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Dear Shadows® user, 

The Shadows software is the result of many years of work, thousands of hours of 
development to make it easy to use the science of sundials and astrolabes. 

I started to develop Shadows in 1996 and I published it for free on the Internet in 
1997, while a few homes only were connected. During the following years, Web 
surfers have submitted suggestions, contributed to the testing of new features, and 
have offered to translate the user interface and the user manual.  

Twenty five years after, Shadows has become the most popular software for the 
design of sundials. Tens of thousands of users around the globe are using Shadows, 
from simple enthusiasts to serious amateurs or professional sundial makers. 

I spent long hours to write this manual, which goes far beyond the simple explanation 
of the software features, and is a genuine reference on sundials, astrolabes and other 
astronomical tools. During the development of the software as well as when writing 
the manual, I have been vigilant to turn complex concepts and equations into easy-
to-use features, in order to allow non-specialists and the general public to enjoy.  

If you only discover Shadows, you will see that the freeware version is complete and 
of excellent quality. However, I encourage you to acquire a Shadows Pro license to 
enjoy the power of the full version and to support its development. I regularly receive 
messages of users from around the world, sometimes with photos of the sundials they 
made using Shadows – they can be seen in the gallery of sundials made by users on 
the Web site www.shadowspro.com. Do not hesitate to send your realizations.  

Thanks for supporting this work and enjoy reading this manual. 

     François Blateyron 
 

 

 

You can download Shadows by flashing this QR code. 

 

  

http://www.shadowspro.com/
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PART 1 – INTRODUCTION TO SHADOWS SOFTWARE 

 

Introduction 

Shadows is a software package for designing, calculating and drawing sundials and astrolabes. It is designed and 
developed in France by François Blateyron. Shadows celebrated in 2022 its twenty-fifth anniversary of presence on 
the Internet!  

Users are provided with a complete toolbox with which to build, orient and understand all kinds of sundials. It draws 
the different parts of an astrolabe and allows the user to move the mobile parts on screen. Shadows also offers 
complete solar and lunar ephemeris and several graphs and tools related to the sun. It is a great educational tool for 
teachers, animators and children. 

Shadows in its standard level, is a freeware program. You can use it freely for your personal use and even distribute 
it to your friends, provided you keep all original files together (including the installation program and documentation). 
This standard version contains many useful functions and allows the construction of various types of sundials. 

Shadows Expert is an advanced level provided for skilled users wishing to explore more technical features and 
additional sundial types. Shadows Pro is made for the most experienced, sophisticated and demanding users and 
professional sundial makers and opens access to astrolabes and 3D visualization of sundials. These two latter versions, 
Shadows Expert and Shadows Pro, require the purchase of a license (see www.shadowspro.com/license). 

Check out the web site for new versions: 

  www.shadowspro.com  

Shadows allows for automatic detection of new versions as they become available on the web site – if the computer 
is connected to the Internet. If a new version is available, a message will inform you to download it or to consult the 

page that describes the new version. This function can also be launched manually from Help >  Check if a new 
version is available … 

In the PDF version of this user manual, click here to access to the Content Table. 

Installing Shadows on a PC 

Shadows is developed for the latest version of Windows® 10 and Windows 11. It is also compatible with Windows 8.x 
and Windows 7. Shadows is a 64-bit application that requires a 64-bit version of Windows. Under some circumstances, 
Shadows can also run under macOS using Wine, Parallels Desktop, or VMWare. However, Shadows is not compatible 
with platforms based on ARM architecture (Apple Silicon M1 to M4 or Qualcomm SnapDragon). Note that technical 
support is only provided on Windows x64 platforms. 

Instructions to install Shadows 

1. Download the latest version of Shadows on www.shadowspro.com 
(the installation file shadows.exe is approximately 35 MB) 
 

2. Start installation 
a. During the installation, choose the language and click on Next 
b. Read the End User License Agreement, if acceptable, check the box: I understand… then click on Next 

c. Click again on Next, unless you need to change the installation folder.  
d. Select how you want the icons to be created and click on Next, 
e. Wait until the installation is finished. 
f. Finally click on Finish. 

3. The program is now installed.  

http://www.shadowspro.com/license
http://www.shadowspro.com/
http://www.shadowspro.com/
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a. Under Windows 7 or earlier versions: you can access to Shadows from the Start menu > All programs 
> Shadows 

b. Under Windows 8 and Windows 10/11: access Shadows by typing its name in the Search area, or by 
adding Shadows on the Windows startup screen. 

Installation of the Shadows license file 

When a Shadows Expert or Shadows Pro license is ordered, it is delivered by E-mail in the form of an encrypted text 
file and an activation code. The license is included on the USB key when the box version is ordered. 

1. Copy the license file into the folder Documents\Shadows Data  
2. Start Shadows. A dialog should ask you to associate the license with your PC. See below the procedure. 

Important! Please keep a copy of your license file in a safe place in case you need to reinstall your hard drive or 
change to a new PC. 

Associate the license with the PC 

The license has to be associated with the PC. The association procedure is automated if you have an active Internet 
connection. 

When the license is installed but not yet associated, a dialog box is displayed at launch. Certify that you own the 
license and click on the button Associate the license to the PC. 

Once the license is associated, you do not need to be connected to the Internet. 

If you get a communication error at this stage, see Manually associate the license below. 

Manually associate the license 

If you do not have an Internet connection, or if there was a communication error during association, you need to 
send to fblateyron@shadowspro.com the text file located in My Documents > Shadows Data > Association. Your 
manually associated license will be sent back to you by e-mail, and you will need to copy it into Documents > Shadows 
Data. 

  

mailto:fblateyron@shadowspro.com
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Credits 

Shadows has been fully designed and developed by François Blateyron (the author). The user manual, illustrations 
and photographs are also by the author.  

The author received the Julien Saget Medal from SAF - Société Astronomique de France (French Astronomical 
Society) and the Sawyer Dialing Prize from NASS (North American Sundial Society). 

The author wishes to thank the people who helped him during the development by sending suggestions, testing the 
program or translating parts of the documentation or the user interface. 

Translations of the user interface have been kindly provided by: 

English collective contribution  

German Claudio Abächerli, Carmen & Axel Wittich, Sonja Lejeune, Marco Tomljanovich, Karl-Peter 
Emmelmann, Christian Haack, Hermann Dellwing, Rita Gautschy, Siegfried Netzband, Ignaz Lorenz 

Spanish Carlos María Sánchez Rodríguez, Gilberto De Hoyos C, Jesús San José Hernández, Mario D. 
Crespo, Isabelle Blateyron, Rafael Rodríguez Martín, Vicente Javier Fernández Gallego, Eduardo 
Bolufer Catalá 

Italian Claudio Abächerli, Marco Tomljanovich, Federico Bettinzoli, Luigi Massimo Ghia 

Portuguese  Hugo D. Valentim 

Brazilian Portuguese Hugo D. Valentim, Rogério Luís Brochado Abreu, Juarez Silveira Sant'Anna, Willyan Becker 

Dutch Fer J. De Vries, Thibaud Taudin-Chabot 

Hungarian Tulok László 

Russian Serge Zukanov, Alexei Krutiakov 

Slovenian Stane Accetto 

Polish Maciej Michalski, Mirosław Danch 

Greek Vangelis Skarmoutsos 

Czech Jaromír Ciesla 

Arabic Ahmed Ammar, Kamoun Sofien 

Catalan Gabriel Guix 

Romanian SRPAC / Radu Anghel & Dan-George Uza 

Persian Mehdi Golchin 

Help files and the user manual have been translated by: 

English collective contribution 

German Karl-Peter Emmelmann, Siegfried Netzband, Nicolas Feierstein, Rita Gautschy, Hermann Dellwing 

Spanish Rafael Rodríguez Martín, Carlos María Sánchez Rodríguez, Vicente Javier Fernández Gallego 

Italian Marco Tomljanovich, Luigi Massimo Ghia 

Brazilian Portuguese Juarez Silveira Sant'Anna 

Polish Maciej Michalski 

Czech Jaromír Ciesla 

Many thanks also to the many users who helped testing Shadows, who suggested ideas of new features or 
contributed to promote Shadows around the world. 

Special thanks to Kurt Berndt and Douglas Gennetten for proof-reading, correcting, and improving this manual in 
English. 
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Features of the three license levels 

Shadows (freeware) 

The basic level of Shadows is free. 

It comes with a robust set of functions and full documentation. Basic features found in all levels of Shadows include:  

• Plane sundials with polar style (horizontal, vertical declining, equatorial, polar, meridian) 

• Sundials are drawn fullscale, at any size and any orientation or reclination 

• Compatible with any location on Earth, in the Northern or Southern hemisphere (6,300+ locations installed) 

• Styles are drawn fullscale 

• Tables of coordinates of hour line points and declination arcs 

• Reporting of solar or mean time, with or without longitude correction 

• Text frames that can be moved and resized on the sundial, with preinstalled list of mottoes in Latin, English, 
German or other languages 

• Export of coordinates to Excel 

• Copy-paste of drawings in bitmap format 

• Equation of time is drawn in various forms 

• Drawing of a protractor and azimuth circle 

• User manual of more than 150 pages, fully illustrated 

• User interface translated in 17 languages 

Shadows Expert 

Shadows Expert is a level dedicated to users who want to access more advanced functions in the program. Shadows 
Expert adds the following features: 

• Analemmatic sundials 

• Cylindrical sundials (shepherd’s dial, polar, armillary ring, vertical cylinder) 

• Spider sundial 

• Solar ephemeris tables 

• Drawing of Italic and Babylonian hours 

• Insertion of image frames and clipart on the sundial 

• Export of images in EMF format (vector format) 

• Drawing of the construction layout of a sundial 

• Simulation of the roof's shadow on the sundial 

• Change of orientation and reclination of a sundial 

• Tool for the determination of a wall's declination 

• Direction rose 

• Mariner’s astrolabe 

• Planisphere (mobile sky chart) 

Shadows Pro 

Shadows Pro is the most advanced level and is made for professional sundial makers and power users. Shadows Pro 
adds the following features to Shadows Expert: 

• Planispheric and universal astrolabes, moveable on screen 

• Vertical declining analemmatic sundial 

• Horizontal and declining vertical bifilar sundials 

• Interactive 3D view of sundials and multiple sundials 

• Export of 3D models as OBJ format, compatible with 3D printing 

• Drawing of azimuth and altitude lines on the sundial 

• Sidereal and astronomical hour lines 

• Colored background outside solstice arcs  

• Colored background between declination arcs 

• Lunar ephemeris 
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• Solar graph (azimuth-altitude) with horizon mask 

• Export of drawing layout in DXF and SVG 

• Export of files for laser cutter/engraver 

• Tool for the calculation of sundial parameters from a photo 

• Tool for the calculation of a horizontal sundial parameters from its hour lines 

• Efficiency graph of a solar panel 

Order a Shadows Expert or Shadows Pro license 

Shadows has been the only freeware program to offer so many simple to use and powerful features for designing 
sundials. Available since 1997, Shadows continues to evolve and improve with new features but remains simple and 
easy to learn and use. 

Shadows is the result of several years of work and countless hours of programming to provide a simple way to access 
the underlying science of sundials and astrolabes. By ordering a Shadows Expert or Shadows Pro license, you not 
only unlock the full potential of the program but also support the development efforts by the author and contribute 
to improving the program.  

Shadows is the freeware level that everybody can download and use. 

Advanced levels, Shadows Expert, and Shadows Pro require the purchase of a license. Prices are given on the page 
Buy Shadows Pro on www.shadowspro.com  

Do not hesitate, upgrade to Shadows Pro and enjoy its powerful features! 

Free evaluation of Shadows Pro 

Shadows Pro can be evaluated for 30 days for free. Download and install the latest version and go to the Help menu 
and choose Discover Shadows Pro… In the following dialog box, enter your name and E-mail address. A message will 
be generated with an encrypted string corresponding to the hardware signature of your PC. Send this message to the 
mentioned address. 

You will then receive an evaluation license that you need to save into the Documents\Shadows Data folder. 

During the evaluation, you will be able to access to all the advanced features included in Shadows Pro. The evaluation 
can be requested if you use Shadows or Shadows Expert. It can be requested only once. 

Moving the license when changing of PC 

You may move your license to a new PC by removing the current association (see the Help menu) and by copying it 
to the new PC into the Shadows Data folder. At the first launch on the new PC, you will need to associate the license 
by following the instructions on screen (as for a new installation). This operation is not counted under the warranty 
and does not affect the limit number of replacements. 

Warranty in case of license loss 

Shadows Expert and Shadows Pro licenses come with a two-year warranty, that will allow you to obtain a free 
replacement of your license, in case you change of PC (renewal, lost, stolen or damaged PC). This operation requires 
a manual action from the author. During the warranty period, the license can be replaced as required.  

After the warranty period, it is possible to subscribe to a new warranty period for two years (see on the site). 

The status of the maintenance plan can be checked in the Help menu > Maintenance plan. 

http://www.shadowspro.com/
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If you lost your license, go to the page www.shadowspro.com/license and renew the Maintenance Plan. You will 
then receive your license, cleared from previous associations, and ready for association on a new PC, after having 
installed Shadows. 

Loading and saving files 

Creations made in Shadows, sundials or astrolabes, are saved into a file with CDS extension. Shadows automatically 
saves the creation when exiting.  

If the user did not use the command File > Save (Ctrl-S) or File > Save as…, it will be saved into the file named 
CurrentFile.cds in the Shadows Data folder.  

If the user already saved it into a specific file and location, Shadows will ask whether it needs to be saved when exiting. 
When loading a specific file, modifications will be saved in it when exiting Shadows, after user validation, unless a 
new sundial or astrolabe is created or a command File > Close is used. 

Translation 

This manual has been mainly translated by Shadows users (see page 9) and partially by machine translation (for small 
additions). You can improve this translation by sending your corrections to the author (info@shadowspro.com).  

http://www.shadowspro.com/license
mailto:info@shadowspro.com
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PART 2 – SUNDIALS  

 

Introduction to sundials 

A sundial is a device from which time can be read using the position of the sun, or more precisely using its hour angle, 
or sometimes its altitude. Known since the most ancient times in its most simple form, it spread from the renaissance 
to the 19th century and then slowly became obsolete, due to the growing success of horology. People started to be 
interested again by sundials after the 1980s and the subject is very popular today. 

 

In all languages, “sundial” contains both 
a reference to the sun (noted in red) and 
to the measure of time (noted in blue), 
such as a dial or a clock. 

Studying sundials will allow you to discover various disciplines: history, techniques of art (fresco, engraving, etc.), 
philosophy of mottoes, celestial mechanics, and many more.  

It is possible to design a sundial on just about any support (plane, cylindrical, spherical...), of any orientation and for 
any location. This manual describes several types of sundials but other types exist, sometimes more exotic than useful. 
The layout of a sundial (lines, arcs, texts) can be very diverse and can provide all kinds of information: solar time, civil 
time, season, date, sun's declination, the hour of sunrise or sunset, the hour of another city, etc.  

If you intend to design your own customized sundial, you will find everything you need in this manual. You can start 
by downloading the freeware program Shadows that will do all the calculations for you and print all the drawings you 
need. 
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How a sundial work? 

 

The Earth rotates around its axis in 24 hours. A rotation is 360°, so 
the speed is 360°/24h = 15° per hour. An hour represents 15°, or 
inversely, 1° represents 4 minutes (24h x 60 min / 360° =  
4 min per degree). 

If you divide a disk into 24 sectors of 15°, with a perpendicular axis, 
and if you orient this setup such as the axis is parallel to the Earth 
rotation axis, you obtain a device that can measure Solar Time. It is 
an equatorial sundial. 

 

 

Depending on the latitude of installation, the axis of the sundial will 
be more or less inclined with respect to the horizontal plane. But 
the axis will always point to the North pole (in the Northern 
hemisphere) or South pole (in the Southern hemisphere). 

 

 

By extending the sector separation lines to the horizontal plane, you 
obtain the layout of a horizontal sundial. The sun rising on the east 
side will cast a shadow on the west side in the morning. It will cast 
a shadow on the east side in the afternoon. At Solar noon, when the 
sun transits on the local meridian, the shadow will be aligned with 
the north-south axis. 

Extending the sectors to a vertical plane, creates a vertical sundial. 
Similar projections can be extended to any plane or any orientation 
and declination, or even on any surface (cylinder, cone, sphere, etc.) 
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During Summer, when the sun is high in the sky, the shadow is the 
shortest. During Winter, it is the longest. At the equinoxes, shadows 
are all within the equatorial plane and will follow a straight line on 
the sundial. 

So, to summarize: 

• A sundial can mark Solar Time by measuring the hour angle of 
the sun, at a rate of 15° per hour. It leads to the layout of hour 
lines.  

• A sundial can mark seasons between solstices, or even the 
date of the year. It leads to the layout of declination lines. 

A lot of other indications are possible, as will be shown in this 
manual. 

 

Designing a sundial with Shadows 

Preliminary information to collect 

Before starting the design of a sundial, you need to collect information that will be required during the creation 
process. 

1. Location of installation 
2. Orientation and/or reclination of the support 
3. Type of sundial 

Once the sundial is designed, you may configure the following options: 

• Dimension of the sundial plate (width/height) and its shape (rectangle, disk, …), 

• Indications given by the sundial (solar hours, Babylonian hours, …), 

• Furniture, motto and labels on the drawing. 

Location of installation 

Contrary to commercial sundials sold in garden shops and designed for an average latitude, your sundial can be 
customized specifically for your location. The location is defined by its latitude, its longitude and its time zone.  

Shadows includes a database of 6,300+ locations already configured. You may also want to add your favorite locations. 
For a sundial marking solar time, only the latitude matters. Sundials marking civil time (as shown on clocks and 
smartphones) require longitude and time zone correction. Other location files can be downloaded from the page 
www.shadowspro.com/en/downloadlocations.html, with a total of more than 300,000 locations, compatible with 
the Shadows database. 

A precision of 1 arc-minute is enough for the longitude as it corresponds to 1 km to 1.5 km of distance in the east-
west direction. With a precision of 1 arc-second, you can reach 20 meters. 

Orientation of the sundial plate 

Contrary to what most people think, sundials do not necessarily need to face south. It is possible to have them 
declining towards east or west, or even north. It just requires illumination by sun light for at least part of the day, 
part of the year. 

The declination angle is the horizontal angle between the direction perpendicular to the wall and the direction of the 
local meridian. If the wall is facing exactly south, its declination is zero. If it faces east, the declination will be 90° east. 

The inclination angle is the vertical angle between the horizontal plane and the sundial plate. A vertical sundial is 
inclined by 90° while a polar sundial is inclined by the latitude of the location. 

http://www.shadowspro.com/fr/downloadlocations.html
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Dimension of the sundial 

Do you want to create a monumental sundial for your town square or just a pocket sundial? It is time to think about 
the consequences of size. With a small sundial, you can print its drawing on one or several sheets of paper and 
transfer the drawing onto the final material. With a larger sundial, you will need to draw lines using their coordinates 
and angle. The weight of the sundial is also important, especially if you plan to install it high on the wall of your house. 

Type of sundial 

Do you want to make a sundial with a polar style? Or with just a perpendicular style (gnomon)? Or an analemmatic 
sundial, a shepherd’s sundial, or an armillary sphere? Before starting, check the type of sundial that would best fit 
your needs. 

Indications given by the sundial 

The sundials that we see during holidays are usually giving local solar time. But sundial can provide other types of 
information. Read the section called Indications given by the sundial to know what information can be displayed on 
your sundial. It will also impact its readability, its design and its aesthetic.  

    

Decoration 

Many considerations can go into the decoration of a sundial. These including its shape, the color of the plate, the 
shape of the style, the color of hour lines and declination lines, the border, the font used for text labels and the motto, 
the motto text itself and any drawing you may add on the sundial (animals, landscape, church, etc.), to name a few. 

    

Quick creation of a sundial from the home screen 

When you launch Shadows, a home 
screen with icons is displayed. Icons 
allow users to select the main features.  

If you use the freeware level Shadows, 
some features are locked and indicated 
by yellow or red markers in the upper 
right corner, depending on whether 
they are enabled in Shadows Expert or 
Shadows Pro, respectively.  

A Shadows Pro license allows 
unrestricted access to all features in the 
program. 
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You can display the home screen at any time by clicking on the icon  on the top-left tool bar. 

Create a new sundial from the File menu 

A sundial can also be created with the help of a 3-stage wizard by selecting File >  Create a Sundial … 

 

On the first screen, choose the location where you plan to 
install the sundial. Select the country from the top dropdown 
list and select the city from the main list.  

If your location is not on the list, you can add it. 

Usually it is sufficient to choose a city near your exact 
location. A difference of a few kilometers is not usually 
significant. 

Click on Next > 

 

In the second screen, choose the category of sundial from: 

• Sundial with polar style (classical) 

• Analemmatic sundial 

• Cylindrical sundial 

• Bifilar sundial 

Click on Next > 

 

Certain types of sundials are available only in Shadows Expert 
or Shadows Pro. 

 

For a sundial with polar style, select the type from the 
dropdown list. 

In case of a declining sundial (or reclining), you need to enter 
angles in the edit field above drawings. 

Each sundial may be configured as a meridian dial that is 
read-only between 11 am and 1 pm if you click on the check 
box Make it a meridian sundial 

Click on Finish 

 

For an analemmatic sundial, select its type using the radio 
buttons. 

In case of a vertical declining sundial, select its declination 
angle. 

 

Click on Finish 
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For a cylindrical sundial, select its type using the radio 
buttons. 

 

 

Click on Finish 

 

For a bifilar sundial, select its type using the radio buttons 
and set the height of both threads, and if needed, the 
declination, in case of a vertical bifilar. 

 

 

Click on Finish 
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Choose a place for your sundial 

One can install a sundial anywhere, as long as it receives some light from the sun during a part of the day. The majority 
of people think that only a wall oriented south (or north in the Southern hemisphere) can receive a sundial, but you 
should not restrict your choice to that. On the contrary, the most original dials (regardless of their decoration) are 
almost always oriented between the cardinal points, and sometimes they are not vertical. 

You should consider the following points before selecting a site: 

• duration of daily illumination during the year, 

• visibility from the street or the garden, 

• exposure to bad weather (wind and rain), 

• accessibility for the sundial installation, 

• risk that plants and bushes may obscure the sundial, 

• risk of deliberate defacement or robbery, 

• risk of injury to people caused by the style (especially for a metal style on a horizontal or equatorial dial).  

Below, are some possible places for the installation of a sundial: 

In the garden 

• A horizontal or equatorial sundial can be placed on a small column at the junction of two paths. The column 
should not exceed 1.2 meters in height. 

• A meridian dial can decorate a pillar or a tree facing south (north in Southern hemisphere) in a place lit 
around midday all the year. 

• An armillary sphere, a kind of equatorial dial drawn on arches, can replace a sculpture in the middle of the 
garden. 

• On one (or both) of the pillars of an entry gate. The dial offers the time to the passers-by and reminds them 
that the landowner is a sundial lover. 

• A staircase, with its stone or concrete handrail, can receive a declining and inclining sundial, a supreme 
luxury as it is rare and difficult to design (except with the help of Shadows!). 

On the front of a house 

• A wall facing the south (north) will be adequate for a vertical direct south (north) dial. If the wall is slightly 
declining, you can still orient the face of the dial directly south (north) using shimps. 

• A wall facing east (exactly or declining between 80° and 100°) or facing west, is an excellent place for a nice 
direct east, a direct west, or a vertical declining sundial. These dials are lit only during the morning or the 
evening. Their drawing is somewhat Spartan, so they are often richly decorated and have a motto adapted 
to the rising or setting of the sun. 

• A wall declining between from 20° to 70° towards east or west offers more possibilities. The hour lines in 
this case are already a nice decoration on their own. 

• A wall facing the pole? A direct north (south) sundial, lit for only a few moments in the day (and almost 
never during the winter) would be an interesting object with an eccentric decoration and an incisive motto. 

• Above the entrance door of a house, so that visitors can see the dial and its motto which affirms the 
hospitality of the occupants of the house. 

Inside the house! 

• Facing a picture window, under a bow window, in a corridor facing the east and lit at the sunrise anywhere 
inside the house, where the sun enters and shines directly on the dial in the room. In this case, the sundial 
could be made from a more delicate and precious material than an external dial. 

• On the ceiling, with a mirror to send the sunlight upwards. In this case, the lines must be reversed, but the 
originality is guaranteed! 
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On the roof of the house! 

• Why not use the slope of the roof to make a large sundial visible for more than a hundred meters from the 
house? The style can be installed for the occasion, but you can also use the chimney or an antenna. A polar 
sundial can be suitable for houses oriented north-south. 

Elsewhere... 

• On the wall of the local school. It is a good opportunity to set up an educational project with pupils, teachers 
and parents. Concepts of celestial mechanics, astronomy, calendars and time become relevant topics. 
Workshops covering topics from the design to the installation can be planed. And why not have an official 
opening with an inaugural speech by the mayor or the headmaster? 

• On a building in your village or town. Do not hesitate to propose a project to your mayor, he or she will 
surely be interested. 

• On your neighbors’ house. 

If you discuss sundials with people around you, they will probably ask questions and may eventually ask you to 
prepare one for them.  

Determine the longitude and latitude of a place 

Establishing the geographical location of the sundial is fundamental for the precision of the dial. The simplest solution 
is to use a GPS device or a GPS app on a smartphone. You’ll get the position with precision to a fraction of an arc 
second which is more than sufficient. 

You can also do it the old way with a map of the location having a very precise scale such as 1:100000 or even better 
1:25000. You will have to find your geographical longitude and latitude. Both can be measured using the method of 
interpolation. 

Note: to achieve a reliable interpolation, the two references shouldn’t be too far apart to compare the charted area 
accurately. Maps are usually made using a Lambert projection that is approximately square over short distances.  

Find the longitude 

First find on the map a vertical line left and right of the actual place. Find the readings of those lines, being G1 and 
G2. Using a graduated ruler, measure the distance in cm (or mm) L1 between those two lines. Next measure the 
distance L2 between the vertical line G1 left of the place if east of the Greenwich meridian or right of the place if 
west of Greenwich meridian. The longitude will be:  

LONGITUDE = G1 + (G2 - G1) * L2 / L1 

with G1 and G2 as longitudes left and right of the location (or in case of a western longitude right and left of the 
location). 

For example: for the village Villers Buzon, France (Doubs): 

(using a 1:25000 map) 

 

G1 = 5° 50’  

G2 = 5° 55’  

L1 = 252,5 mm  

L2 = 58,0 mm 

Longitude = 5° 50’ + (5’)*58,0/252,5  

     = 5° 51’ 09" Est 
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A precision of 1 minute is sufficient. Make sure you take the readings in degrees and not in grads which are sometimes 
also used on maps. 

Find the latitude 

Proceed as described above except that you now have to use the horizontal lines to be marked as G1 and G2. 

For Villers Buzon:  

 

 

G1 = 47° 10’  

G2 = 47° 15’  

L1 = 371,0 mm   

L2 = 273,5 mm 

Latitude = 47° 10’ + (5’)*273,5/371,0  

   = 47° 13’ 41" 

Enter the location in the database 

Once you have found the coordinates enter the location in the database in order to conveniently use the readings 
again for another sundial at this location. 

Tools menu >  Edit the location database… 

Or when creating a sundial, click on Add a location… 

 

You can enter the geographical coordinates with an 
accuracy of 1 arc-second.  

The time zone is very important. In Western Europe, the 
time zone is UT+1h (except for UK and Portugal that are at 
UT). Do not take into account the Daylight Saving Time. 

If you do not know the coordinates, you may find them 
from Google Maps or Google Earth and copy-paste them 
directly in Shadows. 

To know how to import coordinates, read the section Add 
new locations to the database at the end of this manual. 

It is now possible to enter or copy-paste an angle in 
decimal degrees, in the edit box for degrees. Shadows will 
automatically convert it to degrees, minutes, seconds. Just 
remember to use the correct decimal character, dot or 
comma, depending on your system preferences. 
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Coordinate systems 

Horizontal coordinates 

Horizontal coordinates are the ones used in our usual life. They are specific to a particular latitude. They are used to 
describe the position of a celestial body in the sky, seen from a particular location. For example, we use azimuth 
(noted A) and altitude (noted h) of the Sun to calculate sundials layout. By convention, in Shadows, azimuth is count 
from the South, between -180° and +180°, positively to the West. The altitude is counted between -90° and +90°, 
positively above the horizon. 

In the Northern hemisphere, when facing the South meridian, with the pole behind us, the Sun rises on the East side 
on our left and sets on the West side on our right. In the Southern hemisphere, when facing the North meridian, with 
the pole behind us, the Sun rises on the East side, on our right, and sets on the West side on our left. 

  

In the Northern hemisphere In the Southern hemisphere 

Hour coordinates 

Hour coordinates are based on the celestial equator which is the projection of the Earth’s equator to infinite. It is 
centered on the polar axis. The hour angle (noted H) is usually counted in hours, along the equator from the meridian, 
from 0 to 24 hours, towards West. It is from this angle that we calculate Solar Time, by counting 15° of hour angle 
per time hour (360°/24h). 

The declination (noted ) is counted from the equator, between -90° and +90°, positively towards the North pole. 
The apparent Sun’s declination goes between +/- 23°26’ due to the inclination of the Earth axis on the ecliptic plane. 

  

In the Northern hemisphere In the Southern hemisphere 

Equatorial coordinates 

Equatorial coordinates are close to hour coordinates, the declination definined the same way. The right ascension 

(noted ) is defined also along the equator from 0 to 24h, but from a particular point, the ascending vernal point 
(see the following section). The position of the vernal point is calculated from sidereal time and local longitude. 
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In the Northern hemisphere In the Southern hemisphere 

Ecliptic coordinates 

The vernal point , corresponds to the intersection of the ecliptic plane (below in blue) with the equatorial plane 
(below in green). This point is fixed in space (although it is affected by precession and nutation), but its apparent 
position moves with respect to the observer due to the daily rotation of Earth around its axis and to the annual 
rotation around the Sun. The ascending vernal point, at the March equinox (also called the vernal equinox) is the 
origin of equatorial and ecliptic coordinates. The other vernal point is the descending vernal point at the September 
equinox. 

Ecliptic coordinates measure the position of a body around the Sun. The ecliptic longitude, noted , measures the 

position from 0° to 360° on the ecliptic plane. The ecliptic latitude, noted , measures the deviation of a body 
perpendicularly from the ecliptic plane. For the Earth, it latitude is zero because it is included in the ecliptic plane, by 
definition. But for another planet, the ecliptic latitude may be positive or negative. 

 

The division of the ecliptic longitude in sectors of 30°, defines 12 sectors in a year, which defines Zodiacal 
constellations and declination arcs on sundials. 

Find the direction of the local meridian 

The local meridian indicates the north-south direction and defines the meridian plane which contains the style of 
almost all types of sundials. It is therefore usually useful to know precisely where the direction of the meridian is to 
align a sundial. 

Several methods for defining the local meridian are given below. It is interesting and educational to try them all and 
compare their results. 
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Note about the azimuth 

There is two arbitrary conventions to count azimuth. Geographers and mariners are used to count azimuth from the 
North: 0° at North, 90° at East, 180° at South, 270° at West. Others, and in particular astronomers – and it is the 
convention adopted by Shadows – count 0° at South, with an azimuth of +/-180° on each side of the meridian, 
negative to the East. It is an arbitrary convention but it has to be taken care of during measurements. 

Using a compass 

A compass indicates the direction of the magnetic pole. But the meridian direction relies on the geographic pole that 
is not located at the same point as the magnetic pole. On some maps, one can find the magnetic declination of the 
pole and use it to correct the compass direction. The difference between the magnetic and geographic poles can 
reach 20° to 30° in some regions, as in North America! Nowadays, the magnetic pole is located 82° north, 113° west, 
in the north part of Canada (See the following site for more information). Some locations have local magnetic 
disturbances (due to mountains for example) and it is sometimes necessary to check the value of the local magnetic 
declination on a map. The magnetic declination evolves rapidly with time. 

 

Magnetic declination, epoch 2020. 

Source: http://www.magnetic-declination.com/what-is-magnetic-declination.php 

The map above gives the magnetic declination between the directions of the magnetic north and the geographical 
north. Blue indicates a declination towards the west and red towards the east. The declination is quite high in eastern 
Europe, Africa or China. 

The measurement should be made using a precise compass, graduated in half-degrees. In order not to disturb the 
reading, you must be away from any metallic objects such as cars, drainpipes, walls with metallic structure, etc. Then 
the compass reading must be corrected by the magnetic declination. 

Using the sun's passage to the meridian 

You will need a vertical plumb line above a horizontal ground (or table). Using Shadows ephemeris, calculate when 
the sun will pass the meridian for your location on a given date. At that precise instant, the shadow cast by the sun 
is aligned exactly with the meridian. Mark the position of the shadow on the ground. Place another mark right below 
the plumb line. The meridian is the line joining these two marks. The drawback of this method is that it is only valid 

http://www.magnetic-declination.com/what-is-magnetic-declination.php
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at one instant. If a cloud blocks the sun at that instant, you need to wait another day. A better value is often obtained 
by averaging several measurements made on different days. 

Using bisectors 

You need a vertical plumb line above a horizontal piece of wood or a table. Draw a series of concentric circles from a 
center point above which you install the plumb line. You can attach a small ball on the line to have a clear shadow of 
the line on the ground. The diameter of circles will depend on the height of the ball. 

 

The measurement starts in the morning, by marking the ball's shadow each time it crosses a circle. Continue through 
the afternoon until you have two marks for each circle. These marks are symmetrical with respect to the meridian. 
Next, draw a line joining the two marks of a given circle and mark the midpoint. The meridian is found by drawing a 
line from the center of all circles, passing through all midpoints. 

Find the declination of a wall 

In the following examples, the Sun’s azimuth A is measured from the meridian (direction of the South when in the 
northern hemisphere). 

 

 

The declination of a wall (D) is the angle between the 
perpendicular axis of the wall and the local meridian. This angle is 
also found between the wall plane and the east-west axis. The 
declination is defined as positive towards west and negative 
towards east. A wall facing south will have a declination of 0° (in 
the Southern hemisphere it will be for a wall facing north). For a 
wall greatly declining, for example facing north-west, its 
declination will be between 90° and 180°. A wall facing north is 
declining by 180°.  

In addition to the methods given below, it is also possible to find the direction of the local meridian (see the previous 
section) and to measure the angle between the wall and the meridian (then do not forget to subtract 90° to find the 
wall declination).  

Method using a protractor and a plumb line 

 

 

First you need to print the Azimuth circle, from the Tools menu in 
Shadows. Cut it in two parts along the east-west diameter and stick 
it on a semi-circular piece of cardboard.  

Place this protractor perfectly horizontal, its straight part 
(diameter) on the wall to be measured. Then, install a plumb line 
so that its shadow will pass through the center of the protractor.  

Write down the angle value (L) given on the protractor by the 
shadow of the thread and the time the measurement. When the 
sun is exactly facing the wall, you should obtain a value close to 0°. 
If you use a commercial protractor that have 90° in the middle, 
subtract 90° from your observation. 

In the ephemeris calculated by Shadows, calculate the azimuth (A) 
of the sun for that instant.  

The wall declination (D) is obtained by subtracting the angle (L) 
read on the protractor from the azimuth of the Sun (A); 

D = A - L 
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Method of the chord 

 

 

You need to attach two sticks of wood of length (l) by a hinge so 
that it makes a kind of compass. A third stick is installed 
perpendicularly to the others, vertically. On its summit, attach the 
thread of a plumb line. This device can be installed on a horizontal 
table placed against the wall. 

Open the hinge so that one stick stays horizontally against the wall 
and the other is facing the sun so that the shadow of the plumb 
line is passing through the hinge. 

With a tape measure, measure the distance (m) between the two 
stick ends. 

Calculate the azimuth of the sun (A) in the Shadows ephemeris for 
the instant the measurement was taken. 

Then calculate the open angle  between the two sticks:  

 = 2.arcsin ( m / 2 l ) 

and finally, calculate the wall declination by: 

D =  + A - 90° 

Method of the oblique shadow 

This method is the simplest and only requires waiting until the sun is passing in the wall plane, so that the light rays 
are almost parallel to the wall. With the Shadows program, calculate the azimuth of the sun for that instant. The 
declination of the wall is then equal to that azimuth augmented by 90° in the morning and diminished by 90° in the 
afternoon, depending on whether the wall is about to be lit, or about to fall into the shadow. 

Method of the network of tangents 

 

In the Shadows program, you can print a network of tangents 
(Tools menu). This network can be used as a tool to help measure 
the declination of a vertical wall. The paper must lay on the wall, 
and a style is placed perpendicularly to the sheet, on the 0° line. 
The length of the actual style must correspond to the value used 
in Shadows to print the network. 

The style casts a shadow on the network of lines, each line being 
graduated in degrees. This value is the angle between the direction 
of the Sun and the perpendicular axis of the wall. Record the angle 
and instant the measurement is taken. 

In the Shadows program, calculate the azimuth of the sun (A) at 
that instant. The wall declination (D) is simply given by subtracting 
the value of the angle (L) read on the network from the value of 
the azimuth (A);  

D = A - L 

It's better to do the measurement when the sun is not 
perpendicular to the wall but has an angle of at least 40°. 
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Method of circle bisectors 

 

This method is based on the fact that the elevation of the sun is 
symmetrical on either side of the meridian. For example, one hour 
before the meridian, the sun’s altitude is the same as one hour 
after. Here, we do not need to know the time of the meridian 
passing as we will find the bisector circles of the same height. 

Install a plumb line above a sheet of paper placed on a horizontal 
surface. Add an object on the plumb line between half and 2/3 of 
its height. Mark the shadow of this object on the paper at various 
moments in the morning. Draw a series of circles centered on the 
plumb line and passing through the marks on the paper. Wait until 
the shadow crosses the circles and mark these positions again. 
Then draw a line between the two points of the given circle. 
Identify and mark the midpoints. These midpoints are located on 
the meridian line. Finally, measure the direction of that line with 
respect to the perpendicular direction to the wall. 

Calculation tool for the determination of the wall declination 

This tool can be found in the Tools menu > Calculate the declination of a wall… This tool aims to find the declination 
from measurements made by the user, using one of the proposed measurement methods. 

 

How to use it? 

1. Enter the location in the upper-right frame. By default, this location is set to the reference location defined 
in the software. 

2. Enter the date and the instant of the measurements. 
3. Astronomical data are provided only for information. All calculations are being performed by the software. 
4. Select a measurement method in the left frame under the graphic. Enter the additional parameters as 

required. 
5. Proceed to the measurements outside and write down accurately the time of each observation. It is 

recommended to repeat the measurements several times in order to increase the accuracy. 
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6. When back in front of the computer, enter the series of data one by one in the Data frame, then click on the 
button Validate. The software calculates the declination from the data and adds the result to the list. An 
average result is calculated from the list and displayed. The average increases the accuracy by balancing 
random errors due to the manual measurements. 

When the first measurements have been entered, it is not possible anymore to change the method, unless clearing 
the list. Once the final declination value is obtained, it can be used to design a sundial by entering it as a parameter 
into the Create a new Sundial wizard. 

Adjust the size of the sundial 

Size of the sundial plate 

The plate is the surface on which the sundial is drawn. It is drawn in Shadows with a frame that can be rectangular, 
elliptical or polygonal. Its size is defined by its width and its height and can be changed in the Configuration menu > 

 Dimensions… 

Two modes can be used in this dialog: The Manual mode or the Automatic mode. The manual mode allows the user 
to adjust the width and height of the plate independently as well as the height of the style. The automatic mode 
automatically adjusts the height of the plate and of the style from the value of the width. 

  

Here the width of the plate is changed. The 
scale of the drawing is not changed, as the 
height of the style is the same in both cases. 

Adjust the scale of the drawing 

The scale of the drawing is given by the height of the perpendicular style (placed at A). The scale can be changed 
independently from the size of the frame by using the manual mode and adjusting the height of the style. 

  

On the right, the style is half the height as the one 
on the left. The drawing shows more hour lines 
inside the frame. 

Adjust the anchor of the style 

The anchor of the style is the position of point A within the frame. The anchor can be changed from the Configuration 

menu >  Style anchor… 

Point A can be set as a percentage of the frame width and height, or as a distance from the upper left corner of the 
frame. In the former case, point A will remain at its relative position when the frame size is changed while in the 
latter case it will stay at a given distance in millimeters from the corner. 
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Example showing the effect of changing the anchor 
horizontally. 

The anchor can also be changed from the keyboard 
using CTRL-<arrow>. 

Change the shape of the plate 

Shadows offers several geometrical shapes for the sundial plate: rectangular, elliptical or circular, octagonal 

(rectangular with cut corners) or hexagonal. These settings are available in the toolbar by clicking on the icon . 

 

Rectangular plate 

 

Circular plate 

 

Octagonal plate 

 

Hexagonal plate 
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Visualizing and animating the style’s shadow 

It is possible to visualize the shadow of the style on the sundial as it is at the current moment by selecting the Tools 

menu >  View the style’s shadow. If the sundial would not be currently illuminated by sunlight, it will appear 
entirely gray. 

It is also possible to visualize the shadow at another time of the day or of the year by selecting the option Tools menu 
> Animate the style’s shadow... 

 

The shadow can be animated for a given 
instant throughout the year, or throughout 
the day. 

Time can be chosen in solar time or civil time 
(clock time). 

Buttons allow the user to step forward or 
backward or to start an automatic animation. 

 

On the flat view of the sundial, the shadow is drawn. On the 3D view, the shadow is directly generated by the OpenGL 
rendering function, by calculating the portions of the 3D model that are in shadow with respect to the position of the 
directional light that represents the Sun. 

The shape of the style can be changed in the Tools menu > Style shape… The software changes the shape of the 
shadow to match the choice. It is also capable of simulating the light spot cast from an eyepiece (disk with a hole). 

 

Realistic styles are only available in the 3D view. 

The eyepiece can be configured with the 
diameter of the disk that casts a shadow and the 
diameter of the hole that casts a light spot. 

 

Note: in the flat view of the sundial, the width of the eyepiece is not calculated realistically but its length (seen from the style’s 

end) is correct. In the 3D view, the shadow of the eyepiece is realistic and correct. 
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Visualizing the shadow of a roof 

Vertical sundials sometimes turn useless because they 
are in the shadow of the roof, especially during 
Summer, when the sun is high. In order to predict and 
avoid such events, Shadows offers a simulation tool that 
displays the shadow of a roof for various moments of 
the day and of the year. You can therefore verify that 
your sundial is safe of being in the shadow. 

The shadow of the roof is displayed when both options 
Animate the style’s shadow and Show the shadow cast 
by the roof are activated.  

Two configurations are proposed: the shadow of a 
horizontal roof (or a balcony), and shadow of a gable 
roof. 

 

  

Configuration of a horizontal roof Configuration of a gable roof 

 

The roof shadow is displayed on the sundial when the animation of the style’s shadow is activated. 

 



Reference manual of Shadows Pro – © François Blateyron – page 32 

Indications given by the sundial 

Choose indications 

The selection of the type of drawing is made in the 

Configuration menu >  Indications given by the 
sundial 

. 

 

 

Local solar time 

Local solar time is the time obtained directly from the hour angle 
of the sun.  

In this case, it is noon when the sun passes through the local 
meridian (hour angle = 0). The vast majority of sundial display solar 
time. Solar time depends on the longitude of the location. It will not 
be the same solar time at the same instant both in Paris and Berlin. 

A sundial displaying solar time lines can be easily recognized by the 
noon line which is vertical (on a vertical sundial). 

 

Solar time of the time zone 

Here a longitude correction is applied between the place of the 
sundial and the reference meridian of the time zone.  

To enable it, check the box Include the longitude correction.  

With this correction, the sundial will display the same solar time as 
the time zone reference meridian (in Western Europe, UT + 1h), 
whatever the location of the sundial within this time zone. 

 

Mean time (clock time) 

The time is corrected with the equation of time. If the longitude correction is also included, it gives the civil time, and 
which is the time given by a clock or a watch. Daylight savings must be added manually if applicable. 
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The equation of time produces a figure-8 -shaped curve for each 
hour line. Marks or colors can be added in order to know which side 
of the curve should be used. 

The full curves are difficult to read when too many hour lines are 
drawn (e.g., when quarter hours are drawn). This is why it is 
sometimes better to draw only half curves.  

 

  

Half curves are drawn between solstices, 
from June to December or from December 
to June. One can create two sundials 
marking mean time, one working each half 
of the year. 

Left: from June to December. Right: 
December to June. 

Italic hours 

Italic hours are counted from sunset the day before. They can be 
marked from 0 to 24h or 24h to 0; in the latter case, they provide 
the number of hours until sunset.  

Italic hours can also be displayed using the keyboard shortcut 
CTRL-i. 

Italic hours are available in Shadows Expert and Shadows Pro. 

 

Babylonian hours 

Babylonian hours are counted from sunrise. 

Babylonian hours can be displayed using the keyboard shortcut  
CTRL-SHIFT-b. 

Babylonian hours are available in Shadows Expert and  
Shadows Pro. 
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Unequal hours 

Unequal hours are counted 12h from sunrise to sunset.  

Depending on the season, these hours vary in length. In Central 
Europe, they vary from 40 to 80 minutes. 

Unequal hour lines are crossing with hour lines on the equinoctial 
line, as during equinox they have the same length.  

Unequal hours are available only in Shadows Pro 

 

 

Sidereal hours 

Sidereal hours correspond to the hour angle of the vernal point and 
are used to locate stars.  

Sundials that display this type of hours are quite rare and difficult 
to read and interpret.  

Sidereal hours are available only in Shadows Pro. 

 

Azimuth and altitude of the Sun 

This option does not draw hour lines but rather curves representing 
the horizontal coordinates of the sun. Some sundial will only 
provide the altitude (such as for the shepherd’s dial). 

The example on the right shows azimuth lines in orange and 
altitude arcs in green. 

Azimuth and altitude curves are available only in Shadows Pro. 

 

 

Analemma curve 

It is quite common to see sundials with a figure-8 -shaped curve at noon. It is an analemma curve, which represents 
a correction (the equation of time), allowing viewers to read civil time as on a watch. To do so, you must also include 
the longitude correction that has the effect of shifting the curve off the hour line so that it is not vertical anymore 
(unless the sundial location is right on the reference meridian). 

The analemma curve can be displayed from the Drawings menu >  Draw analemma. And it can be configured 

from  Analemma options... 
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Points can be drawn on the curve in order to indicate the date. A point is drawn for the first day of the month and 
then every five days thereafter. When drawing points, their size depends on the line thickness chosen in the Style 
dialog. Their color is taken from the declination arc of the period start. 

Specific hour lines 

 

Solar noon line 

The solar noon line can be drawn across the sundial, by selecting 
the Drawings menu > Draw the solar noon line. 

On a vertical sundial, the solar noon line is always vertical and 
correspond to 12 hours of solar time. 

 

 

Sub-style line 

The sub-style line can be drawn across the sundial by selecting the 
Drawings menu > Draw the sub-style line. 

The sub-style line is the line extending the segment A-B of the style. 
On a declining sundial, this line is inclined. 
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Noon line for other locations 

It is now possible to draw a noon line for different locations. 

On the left example, a vertical declining sundial made for Paris, the 
brown line is the noon line for Berlin and the green line is the noon 
line for Dublin. 

This function is available in Shadows Expert and Shadows Pro. In 
Shadows, it is only possible to draw the noon line of the reference 
time zone. 

The color and thickness of the lines can be changed in the Style of 

lines dialogs . 

 

 

Declination lines 

Declination lines are curves that mark the trajectory of the style shadow during the day. 

Several options can be chosen for declination lines. By default, arcs are drawn for each zodiac sign change. 

Arcs related to ecliptic longitude 

The trajectory of the apparent sun (the ecliptic) crosses the celestial equator at two points: the ascending vernal 
point and the descending vernal point. When the sun appears at one of those vernal points, it announces the equinox. 
Historically, the Earth’s orbit has been decomposed into twelve sectors of 30°, each corresponding to one of the 
Zodiac signs. A declination arc is usually drawn on a sundial when the apparent sun changes sectors. Two of these 
arcs are for the two solstices, another one for the two equinoxes (which are superimposed) 

 

For each sector change, the declination of the Sun can be calculated: 

0° ; +11°29' ; +20°20' ; +23°26' ; +20°20' ; +11°29' ; 0° ; -11°29' ; -20°20' ; -23°26' ; -20°20' ; -11°29' 

It is also possible to decompose the orbit into smaller sectors of 10° of ecliptic longitude. These 36 sectors are called 
decants. 

Arcs related to the declination of the sun 

Because of the inclination of the ecliptic with respect to the celestial equator, the declination of the sun varies during 
the year, from 23.45° above to 23.45° below the equatorial plane. It is therefore possible to draw an arc every 10° or 
every 5° of declination. As the extreme value is not an integer divisor, it is common to draw the solstice’s arcs at the 
same time. 

This option is available in Shadows Expert and Shadows Pro. 

Arcs related to the date 

It is also possible to draw arcs for certain intervals of time: every month, every two weeks or every ten days. However, 
it should be noted that such arcs do not superimpose each other as with Zodiac arcs. The consequence can be too 
many arcs that are too close to each other. That's why this option is recommended only for large sundials. 

If the sundial displays mean time using half analemma curves, arcs of date will also be limited to half a year, allowing 
the creation of two complementary sundials, one for winter & spring and another one for summer & fall. 
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This option is available in Shadows Expert and Shadows Pro. 

Arcs for particular dates 

The trajectory of the shadow on a sundial follows an arc during the day. This option makes it possible to create a 
custom arc on your sundial for a particular date of the year (in addition to the standard declination lines, if desired). 
It allows you to mark an anniversary or birth date. 

This option can be reached from Drawings menu > Anniversary Date.... 

 

Select a date using the lists and click on the button 
Add. 

The freeware level of Shadows allows only one date 
at a time, while Shadows Expert and Shadows Pro 
allow an unlimited number of dates. 

  

Coloring the background outside solstice arcs 

 

A new option in the preference Sundial layout allows the coloring 
of the sundial background, outside the solstice arcs, using a specific 
color.  

The area in between the solstice arcs is still filled with the sundial 
background color selected in the preference Sundial plate. 

This option is only available in Shadows Pro. 

 

Coloring the background between declination arcs 

 

Another option allows the coloring of the sundial background 
between Zodiacal declination arcs, or between equinoxes and 
solstices arcs.  

Predefined sets of colors are presented in the Preferences. In case 
the option to colorize between equinoxes and solstices is selected, 
the lighter color of the selected color set is used. 

To select colors, click on the icon  Sundial layout. 
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This option is only available in Shadows Pro. 

Change the style and color of drawings 

The color and thickness of lines in drawings can be modified from the Drawings menu >  Style of lines… 

 

Click on the name of a drawing element in the 
left list and change its thickness from the 
dropdown list, and its color by clicking on a cell 
of the color picker. 

Alternatively, the color components can be 
entered manually as R (red), G (green) and B 
(blue) values. 

Changing other attributes on the sundial 

The sundial view is configured using the Drawings menu and using icons of the toolbar 

 
Allows the modification of options for the sundial plate, such as using a rectangular, circular, hexagonal 
or octagonal shape, or drawing a double frame, or choosing the background color. 

 
Allows the modifications of drawing options, such as extending hour lines, or selecting the numeral 
format  

 Limitation of the hour span (for example between 8 h and 14 h) 

 Draw/hide hour numerals 

 Use 24 h or 12 h format 

 Use Roman or Arabic numerals for hours 

 Draw hour lines of 30 minutes 

 Draw hour lines of 15 minute 
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 Draw hour lines of 5 minutes 

 Draw hour lines every minute. Should be used only on very large sundials 

 Selection of the font and size of text used for hour numerals 

 Draw the analemma curve at noon 

 Options for the analemma curve 

 Draw/hide declination arcs 

 Options for declination arcs 

 Style of drawing lines 

 Mark the position of the style with letters A and B 

 Draw X-Y axes on the sundial origin 

 Draw the sub-style line. Useful on a declining sundial 

 Draw the solar noon line 

 Draw the noon line for the reference time zone. Includes the longitude correction 

 Draw lines only when the sun illuminates the sundial 

 Extend hour lines to the plate edges 

 Extend all hour lines to the plate edges 

 Draw flatten down style. Visualize its size on the sundial 

 Draw the construction layout. This layout is the ancient way to draw hour lines 

 

3D visualization of the sundial 

With Shadows Pro version 5, it is now possible to display a 3D model of the sundial. This feature is based upon 
OpenGL, a rendering engine language that is compatible with all graphic boards. 

The 3D model of the sundial can be rotated with a click-and-drag of the mouse or using keyboard arrows. The rotation 
is done around two axes, azimuth and altitude. The mouse wheel drives the zoom factor on the model. 

By holding the Shift key at the same time as the operation mentioned above, you can move the model laterally and 
vertically. 
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The 3D view cannot be printed nor copy-pasted, but it is possible to do a print screen of the whole screen and paste 
the image into a drawing program or a word processor. 

3D visualization of multiple sundials 

Shadows offers several examples of multiple sundials, of fix size but made for the current location. 

  

Diptych sundal: made from a horizontal sundial and a 
vertical sundial, sharing the same style. 

Cubic multiple sundial: with a horizontal sundial above, and 
four vertical sundials, due-South, due-East, due-West and 
due-North. 
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Hexagonal polar sundial set: drawn on a hexagonal 
cylinder, parallel to the polar axis. Contains a standard polar 
sundial on top and four declining polar sundials. The sixth 
face is left empty, below. 

Octogonal polar sundial set: drawn on an octogonal 
cylinder, parallel to the polar axis. Contains a standard polar 
sundial on top and six declining polar sundials. The eighth 
face is left empty. 

 
 

A multiple sundial with 26 faces, on a polyhedron called rhombicuboctahedron, which is a cube truncated on its 
edges. An actual example of such a sundial is visible in the botanical garden of Strasbourg, near the observatory and 
planetarium. The version implemented in Shadows has indeed 22 faces, as the three faces reclining towards the ground 
have no sundial layout. 
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Decorate the sundial 

A sundial is not just a set of lines. It should also be well decorated and perhaps have a philosophical motto. The 
decoration may be part of the drawing, around the perimeter, or both. 

The first step is the frame, that can have a border or not. It is quite common to find drawings of animals or plants 
around the polar style (point B), or graphical representation of sun. 

  

This morning sundial, located in the Pragelato valley near 
Sestrieres in Italy, leaves more space for the decoration 
than for the sundial layout. The style is realized by the ski 
stick. The motto is in Piemontese dialect. 

This other sundial, located in Serre-Chevalier, France, 
also leaves a large area for the decoration, and the 
motto is written in a complex series of curves. Again, 
the sundial layout is simple to emphasize the beauty of 
the painting. It’s a real artistic creation. 

The detailed description of decoration techniques is out of the scope of this manual, but the flexibility of the Shadows 
software allows for many possibilities. 

In Shadows, it is possible to insert a vector drawing or an image that can be printed with the sundial. Vector format 
is preferred as it can provide a helpful guide when drawing the outline of the decoration during construction. 

Add some text 

Text frames can be placed on the sundial to add labels, symbols, etc. Text font and size can be modified. Typically, 
text frames are used to label hour lines and other types of lines, or add mottoes and geographical coordinates.  

Insert a text frame from the Frame menu >  Insert a text frame… It can contain the following information: 

• Free text entered by the user 

• A motto chosen from a predefined list 

• A Zodiac symbol 

• The name of the location 

• The type of sundial 

• The geographical coordinates 

The text font, size and color can be modified. 
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Add a motto 

The motto of a sundial is often the part that we remember. It expresses the place of mankind in the universe: 
regarding time, regarding death, or regarding God. The motto is often philosophical, sometimes religious, and usually 
contains a double meaning. Do not hesitate to add a motto on your sundials by choosing one from the list of mottoes 
included in Shadows, taken from a book, a favorite poem, or even from your own inspiration. The motto is a 
statement you wish to make with your sundial. 

Mottoes are inserted through text frames. Shadows comes with more than 550 mottoes in English, Latin, French, 
German, Italian, and other languages. 

 

Select a motto from the list. You can modify it or add 
a comment (usually a translation). The comment will 
not be displayed on the sundial. 

Mottoes are stored in a file, mottoes.txt, located in 
the installation folder of Shadows. 

You may add new mottoes in the file if you have read-
write rights on the installation folder. Don’t forget to 
send the new mottoes to the author so that they will 
be available to everyone in the next version. 

Import an image 

Insert an image frame from the Frame menu >  Insert an image frame …  

Image frames can contain and display files in the following image formats: 

• Windows BMP bitmaps 

• GIF bitmaps, either transparent or opaque, in 16 or 256 colors. 

• JPG bitmaps in 16 bits. 

• WMF or EMF vector drawings 

Bitmap images are made of pixels; they can be used for pictures and photos. Drawings are made of lines and 
geometrical shapes; they can be used for symbols and stylized drawings. 

You may prepare the image in the software program of your choice, save it in one of the formats above and then 
import it into Shadows. Alternatively, you can scan an image in a book or make a custom drawing using vector drawing 
software. 

Examples of vector clipart are included with Shadows, in the sub-folder cliparts of the installation folder. 

Image frames are available in Shadows Expert and Shadows Pro. 

Export drawings 

Copy-paste the view into another software 

This option creates an image of the displayed view. It can be copied either as bitmap image or a vector drawing. The 
latter option is recommended for curves and line drawings because they can be scaled without showing pixels, and 
each part of the drawing can be modified individually. 
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When copying the view as a bitmap image, you can select the resolution in a 
dialog, or in the Preferences. 

The resolution can be a multiple of the screen resolution (e.g., x1 or x4) or set 
as a fixed width in pixels (from 640 to 3000), the height in this case is 
calculated from the image aspect ratio. 

The image is placed into the memory and is ready to be pasted into another 
program. 

Keyboard shortcuts: CTRL-C to copy as a bitmap image, SHIFT-CTRL-C to copy 
as a vector drawing. 

 

The copy in bitmap format  is available in all Shadows levels. 

The copy in vector format  is available in Shadows Expert and Shadows Pro. 

Export a vector drawing 

Export in EMF 

This feature will create a file (with the extension .emf) containing the current view as a vector drawing in Enhanced 
Windows Metafile format. This file format is compatible with most drawing programs and word processors. 

You can then modify any part of the drawing (e.g., the curve representing the equation of time) in a third-party 
program. Some programs are able to drive engraving machines from a vector drawing, or even machine tools. 

EMF export is available in Shadows Expert and Shadows Pro. 

Export in DXF (CAD software) 

The drawing can be exported to DXF format from AutoCAD. Most CAD programs support this format as do programs 
that can drive machine tools. This format contains a series of ASCII codes that describe the sundial drawing. It can be 
loaded and modified in a text editor. 

Only drawings are exported to DXF and some automatic texts, but not text and images contained in frames. If you 
want to have the complete drawing, use the EMF export. 

The DXF format has many variations, and some programs may not load or will interpret differently the DXF file 
generated by Shadows. In case of problems, you may contact the author to try to find a solution or add new options 
to support the variant. 

The DXF export is available only in Shadows Pro. 

Export in SVG 

The SVG format – Scalable Vector Graphics is a popular format on Internet. It can be displayed in a Web browser and 
can be used on a Web page. The SVG export works similarly as the DXF export, with more or less the same features 
and the same limitations. 

The SVG export is available only in Shadows Pro. 

Tables of coordinates 

Tables of coordinates are generated as tab-delimited text files that can be loaded into a text editor or a spreadsheet 
program (e.g., Excel). Tables of coordinates are generated from the Configuration menu > Tables of coordinates. 
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Coordinates of hour lines 

 

The number of lines in the table depends on the 
number of hour lines drawn on the sundial (½ hours, 
¼ hours, etc.)  Each hour line is described by a point 
every five days. When a point is outside the frame, it 
is noted with a star symbol. 

Coordinates of declination lines 

 

Each arc of declination is described by a series of points 
corresponding to hour lines. The name of the arc is given before 
values. It may be a Zodiac arc or decant. It can be for a given date 
or declination, depending on the choice made in the Drawings 

menu >  Declination lines options… 

Coordinates of analemma curves 

 

Points along the analemma curve are given every five days. It is 
used either for the analemma at noon or for mean time sundials 
with each hour line drawn as a complete or half analemma curve. 

Coordinates of hour points (analemmatic sundials) 

 

The ellipse of an analemmatic sundial is described with hour 
points, with the same number of points as on screen. 

Coordinates of the mobile style (analemmatic sundials) 

Allows the drawing of the date line in the middle of an analemmatic sundial. 
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Coordinates of hour lines on the equinoctial line 

 

This table provides intersection points between hour lines and the 
equinoctial line, as drawn on the equinoctial ruler. 

Distances are given from point O (solar noon line) or from point S 
(sub-style). 

Coordinates of special lines 

 

As for hour lines, coordinates of points for Babylonian, Italic, 
sidereal, unequal and azimuth and altitude lines are given. 
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Constructing the sundial 

Choose a material 

In the case of a sundial prepared on a plate that is later installed at its final place, light materials can be chosen to 
allow easy transportation and lifting, unless it is made with mosaic. 

The most frequently used and practical materials are: 

• Wood: Preferably laminated with a waterproof treatment to resist bad weather. You will probably use wood 
for your first sundials. You could also use a composite wood made of small particles aggregated under high 
pressure (e.g., the MDF). This kind of material, often called chipboard, is sometimes used to build office 
furniture or hi-fi speakers. 

• Tiles: You can find tiles of up to 50 cm in gardening shops. They are often reasonably priced and have a 
surface made of some kind of composite material (like chalk or marble). The surface shouldn’t be too 
irregular. There are special paints that harden in an oven which makes it easy to construct a beautiful little 
sundial using this material. 

• Marble: Use this only for small sundials because of the weight and cost. Lines can be engraved by sand-
blasting. Protect the parts that are not engraved with a negative mask. 

• Glass: Choose a sheet of security, smoked, or matt glass which is thick enough to be not too fragile. The lines 
can be engraved or painted. 

• Plexiglas: Lighter than glass and very interesting to work with, but is more prone to scratching. 

• Metal: Sheets of iron, copper, or aluminum can all be engraved and enhanced with oxidation, colors, or 
enamel. 

It is also possible to cast and use a resin color that, when hardened, can be painted to look like wood or metal. The 
advantage of casting a sundial is that you can create several dials using the same mold. The mold can be made of 
silicon-rubber for example, to make it easier to get the dial out of the mold. 

Transfer the drawing on the material 

Shadows can print the dial on several sheets which can be reassembled in order to get a full-scale model. 

For dials of reasonable sizes (up to 60 cm each side), you can paste the paper dial on the background and mark every 
point with an awl. After that, you can trace the lines by connecting the points and engrave and/or paint them. 

Painted sundials may use the technique of a fresco painting on a wet undercoat. This technique is very difficult to 
master because you need to work quickly and without any errors. The materials are the same as used for frescos and 
covering walls: wet chalk and mineral pigments. All the old dials were painted using this technique and they survive 
quite a long time before they have to be restored. Avoid classic mural paintings because they will not last long enough 
and have to be restored about every five years.  

In the case of a fresco-painted dial, you can cut the lines to a width of 1mm to make a stencil, and use a sponge with 
pigment powder to apply the lines. The pigment will be transferred to the wet base at the same positions as the lines. 
Then you only have to paint the lines along the sketches. It is also easy to draw straight lines with paint by installing 
rubber tape on both sides of the line separated by the line thickness. 

For a large dial, it is advisable to work from a table of coordinates and draw lines using a ruler, divider calipers 
(compass), and a protractor. 

Use the equinoctial ruler 

This ruler provides a quick way to draw the hour lines. Access to it from the Configuration menu >  Equinoctial 
ruler and print it. 
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To use this ruler, you place the point B and then draw 
the solar noon line through this point. Then add the 
equinoctial line (in red below) using the angle 
between the equinoctial line and the noon line. 

Trace a line between point B and each graduation of 
the ruler. Positive values are on the right side of the 
noon line, negative values on the left side. It is much 
simpler than plotting the coordinates of each hour 
line from the table of coordinates. 

 

 

Points on the ruler can be exported to an Excel file. It provides distances from point O and hour lines on the 
equinoctial line. Point O is defined as the intersection between the solar noon line and the equinoctial line. 

On some sundials, the ruler and table cannot be used, either because the equinoctial line is not visible or because 
point B is too far outside the sundial plate. 

Step-by-step procedure 

 

Choose the material you want to use for the sundial 
plate, on which you will draw the sundial layout (tiles, 
wood, stone, metal, etc.) 

In our example, the plate size will be 150 x 150 cm. The 
sundial is designed with Shadows at scale 1/10, i.e. 150 x 
150 mm. All measures given by Shadows will then be 
multiplied by 10. 

Step 1. Place the sundial origin (point A) 
somewhere on the plate. 

Step 2. Draw a vertical and a horizontal line from this 
point. 

 

If the sundial is declining, draw the sub-style line: 

Step 3. Measure the sub-style angle given by the sundial 
technical data sheet in Shadows, with a protractor. 

Here in our example, it is 25,9° (measured from the 
vertical) 

If the sundial is not declining, then the sub-style line will 
be vertical (angle of 0°) 
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Step 4. Mark point B by measuring the distance A-B 
(length of the style base) along the sub-style line.  
 

In this example: A-B = 46,3 cm 

 

 

Step 5. Draw a vertical line from point B. 

Step 6. Mark point O by measuring the distance B-O given 
on the equinoctial ruler.  

Point O corresponds to the intersection between the 
equinoctial line and the solar noon line. 

In this example: B-O = 87 cm 

 

Step 7. Draw the equinoctial line from O using the 
equinoctial angle given on the ruler.  

In this example: 64,1° (measured from the vertical) 



Reference manual of Shadows Pro – © François Blateyron – page 50 

 

Step 8. Print the equinoctial ruler on strong paper and cut 
it. Place the ruler along the equinoctial line, and align 
point O with the vertical line passing through B. 

Note: dimensions given by Shadows are to be multiplied 
by 10 to convert mm to cm, i.e., to pass from the mock-
up at scale 1/10 to the full-scale sundial. 

Step 9. Draw the hour lines by joining point B to each 
mark on the ruler. 

 

 

Step 10. Extend hour lines to the edges, then decorate 
the sundial and remove intermediate lines. 

 

Your sundial is now finished. 

 

Create a large sundial 

With Shadows, you can create a sundial of any size by setting the width and height of the plate and the height of the 

style from  Dimensions. On very large sundials it is not advisable to print the drawing to scale as it will likely 
consume too many pages of paper. In this case, the use of coordinate tables is preferable. During the design phase, 
it is good to see the sundial on screen, but above 2 or 3 meters of size, you may experience spurious lines on the 
drawing, as coordinates are getting too large for drawing on screen. 

The solution then is to create a reduced version of the sundial at 1/4 or 1/10 of the full scale. All dimensions are then 
to be divided by this ratio to get back to the real scale. 

For example, a horizontal sundial of 10 m x 4 m, with a style height of 1.50 m, may be modelled on screen at 1/10 by 
entering 1000 mm x 400 mm for the table dimension and 150 mm for the style height. Then multiply all x, y 
coordinates given by Shadows by 10 to build the real sundial. Angles can be used directly as they do not change with 
scale. 

Draw the construction layout  

The construction layout visualizes the graphical method of a sundial used in the past by sundial makers until electronic 
calculators became common. This layout requires only a ruler, a pair of divider calipers (compass) and a protractor. 
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First draw the sub-style passing through points A and 
B. Then draw the segment A-C perpendicularly with a 
length equaling the style height. 

Next draw a line perpendicular to B-C to create point 
D on the sub-style line. This point belongs to the 
equinoctial line. From D, draw a circle with a radius 
equal to the length of the segment D-C. The lower 
intersection of the circle with the sub-style line give 
point E. 

Then, draw another circle centered on E with a radius 
equal to the length of the segment E-D. 

From E-D, draw line segments every 15° and extend them until they cross the equinoctial line. Then hour lines can 
be constructed from point B to these intersections. 

If you want to draw ½ hours, draw segments every 7.5° (15°/2), and for ¼ hours use angles of 3.75° (15°/4), etc. 

Draw the sundial lines directly from the Sun? 

Some people naively think that they can draw a sundial by installing the style in its final position and simply draw the 
position of the shadow every hour. Simply said… it does not work! In reality, to get the correct layout using this 
method, you need to be located exactly on the local meridian line, and you need to make the drawing on one of the 
four days where the equation of time is zero: April 15, June 13, September 1 or December 25. 

 

On the example here, a sundial is drawn for Paris. 
Red lines are drawn from the style shadow on 
October 21, and green lines are drawn on February 
21.  

We can see the large deviation between these 
layouts, both different from the correct layout (in 
black), which corresponds to solar time lines, 
normally expected. 

The best solution to draw a sundial using the sun, is to calculate, for the given date, the civil time corresponding to 
each solar hour line. Then, the marks made from the style shadow at each calculated civil time (noted on your watch) 
will give the correct position of the solar hour line.  

Civil time can be calculated using the ephemeris in Shadows, or by doing the calculation by hand, following the 
procedure explained in the section How to read time on a sundial? 

  



Reference manual of Shadows Pro – © François Blateyron – page 52 

Build the style 

In Shadows, the style position is marked on the sundial with points A and B.  

Point A corresponds to the perpendicular style (also known as the gnomon). Point B corresponds to the polar style 
when it exists. When this point is rejected for being too far from point A, then the style length is truncated to point 
B*. 

Schematics of the style 

 

This drawing is available from the Configuration menu 

>  Schematics of the style. The style is not drawn 
to scale but as a scaled drawing showing dimensions 
and angles. The style height (A-C) and the style length 
(A-B) are given, as well as the positions of points A and 
B in the Cartesian coordinate system used on the 
sundial. 

Point C is the end-point of the style, where sometimes 
a ball or an eyepiece is attached. 

In case you need to draw the style to scale, go to the Configuration menu >  Drawing of the style. It will be 
possible then to use this print out to cut the style from wood or another material. 

The style can be cut from the triangular shape, but also it can be constructed using a rod or any decorated variation 
as long as B-C and A-C are of the correct length. 

The triangular style 

 

It is the simplest style as it is printed by Shadows. Just draw the sub-style 
and install the style on points A and B. It casts a visible shadow and make 
hour easy to read. But the material should not be too thick, or its 
thickness should be taken into account on the drawing. 

 

The triangle may be decorated as sometimes seen on old sundials, but 
always keep the correct position of points A, B and C. Point C casts a 
shadow on a declination line. 

The line segment B-C casts a shadow along hour lines. 
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The polar style 

 

The polar style is a rod attached to point B and oriented parallel to the 
Earth axis. (i.e., along the longest side of the triangle) and pointing at 
the north celestial pole.  

The shadow of a polar style is parallel to hour lines.  

It is sometimes necessary to support the style with a foot (the additional 
rod that strengthens the style). 

 

The polar style may be longer than the normal B-C length. In this case, 
it will be used to read hours but not dates or seasons (with declination 
arcs), unless a marker is added on point C. 

Long styles sometimes have a ball fixed on point C to cast a shadow on 
declination arcs. 

 

The perpendicular style 

 

On some sundials, the style is a simple rod placed perpendicularly to the 
sundial plate at point A.  

In this case, only the very end of the shadow is used for reading hours, 
which is not so convenient. It is sometimes used with ancient hours or 
sidereal hours. 

 

The polar eyepiece (pierced disk) 

 

 

A polar style may support an eyepiece (pierced disk) at its end. 
Alternatively, the disk may be supported by additional legs.  

The hole at the center of the disk must be placed exactly at point C to 
function properly.  

Supporting legs can be attached anywhere on the disk as they are not 
used for reading time. If the disk is attached to the polar style, care 
should be taken so that the polar style is securely attached to avoid 
bending in the wind. 
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Truncated style 

 

East- and west-facing sundials, as well as polar sundials have their polar 
style parallel to their table. Point B, in this case, is rejected to infinity.  

In such a case, a perpendicular style can be used, or a rectangle on one 
side or both sides. If the rectangle is on both sides, it will be necessary 
to mark point C. 

The realistic styles 

In the 3D view, Shadows can visualize the style as a realistic shape, and not only as a simple triangle or gnomon. 
Several models of realistic styles are proposed. Their shadow is the genuine shadow cast by the 3D model. 

These styles are drawn inside the ABC triangle. Users may express their creativity when building the style, as long as 
they respect the constraint of the three points A, B and C (see above). 

     

Realistic styles are also used when exporting files for engraving with a laser cutter, where the style shape is used. 
Note: if the style is truncated, the realistic style is replaced by a triangular style. 

Taking into account the thickness of the style 

In the case of a thick style, the layout has to be adapted to account for the 
fact that between morning and afternoon, the shadow is cast by a different 
edge on the style. In the morning, it is the edge on the west side that cast 
the shadow on the west side. In the afternoon, the east edge cast a shadow 
on the east side. 

Shadows does not handle the thickness in the layout but it is possible to 
modify the layout afterward, by printing the sub-style line (Drawings menu 
> Draw the sub-style). Then, cut the layout along the sub-style line and 
separate the two parts by the thickness of the style. 

 

Photo : NASS repository (St Louis) 

www.sundials.org 

http://www.sundials.org/
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Building a sundial with a laser cutter/engraver 

Since version 5.2, a new export function generates files for engraving and cutting the plane sundial directly on a laser 
cutter (polar style sundials and analemmatic sundials). Two files are created for each element, one for engraving and 
one for cutting. These files are generated into the Shadows Data\Engraving folder. 

The making of each element is done in several passes. First engrave the layout, using a medium power for the laser, 
in order to draw and not to cut. Then, use the cutting file with the maximum power, and double or triple the number 
of passes, depending on the material type and thickness to ensure it is cut throughout. 

The export function for a laser cutter/engraver is available only in Shadows Pro. 

How to read time on a sundial? 

Most sundials are giving local solar time. 

Solar time is defined directly by the position of the sun, with 15° of Hour Angle per hour of time. Earth is rotating 
around its axis in 24 hours, i.e. 360°/24 h = 15°/hour. It is noon in solar time when the sun is passing at the local 
meridian (direction of the south in the Northern hemisphere). 

Solar time depends on the position of the observer, and it is different with longitude. 

On a sundial, the solar noon line corresponds to the highest altitude of the sun in the sky and to its passing at the 
local meridian. It is, therefore, always within the north-south plane and is always vertical on a vertical sundial, 
regardless of its declination. 

To obtain watch time from solar time, you have to apply three corrections:  

• The longitude correction  

• The Equation of time  

• The Daylight-Saving time (DST) when it applies 

The following schematics explains the different paths to follow to convert solar time to civil time and vice versa. 
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Longitude correction 

Europe is using the same Time Zone CET (Central European Time), except the United Kingdom, Ireland and Portugal 
that are using WET (West European Time) and some Eastern countries that are using EET (Eastern European Time). 
Countries that use CET cover a wide span from the Western extend of Spain, with Vigo, to the Eastern border of 
Poland, which corresponds to a span of 2 hours of solar time. For locations at the east of the CET meridian, time is 
shifted towards morning (sun is rising and setting earlier). For locations at the west of the meridian, it is the contrary, 
time is shifted towards the evening and sun is rising and setting later. 

One must calculate the longitude correction with regard to the reference meridian of the local time zone. Or to the 
Greenwich meridian and then compensate for the time shift between time zones. For example, for Besançon, France, 
located at 6° 02' east, the correction with regard to the CET meridian (UT+1h) is: 15° - (6° 02') = 8° 58' of longitude 
distance from the meridian, and (8+58/60)*4 min = 35 min 52 s of time difference. When the sun passes the local 
meridian in Besançon, it already passed the reference meridian almost 36 minutes ago (Central European Meridian). 
For a location east of the reference meridian, you will get a negative value. For example, in Warsaw (21° east), you 
will get -24 minutes, i.e., for the 12 hour of solar time, it will be  
11 h 36 of solar time at the reference meridian. 

The numerical application of the above graph for Besançon, on July 26th, 2014, we get: 
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If we start from Solar Time (red arrows): 

• Solar hour at noon: 12 h 

• Longitude correction: 6° 02' east = – 24 min 8 s + 1h = + 35 min 52 s 

• Equation of time: 6 min 32 s 

• Summer time (DST): + 1 h 

So, when it is 12h of solar time on the sundial in Besançon, on July 26th, 2014, it is in fact 13 h 42 min 24 s on the 
watch (civil time in central Europe). 

On the contrary, if we start from the time given by the watch (green arrow): 

• Watch time (civil time): 12 h 

• Summer time (DST): – 1 h  

• Equation of time: – 6 min 32 s 

• Longitude correction: – 1 h + 24 min 8 s = – 35 min 52 s  

It gives 10 h 17 min 36 s of solar time for noon on the watch. 

This method can also be used to anticipate the civil time of the passing at the local meridian (solar noon), for a given 
location. Or calculate the solar time for any civil time. 
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The horizontal sundial 

This is the horizontal sundial with polar style. Other types of horizontal sundials exist such as the horizontal 
analemmatic sundial described later in this document. 

Geometry of the sundial 

The table of a horizontal sundial is parallel to the horizontal plane of the location (which is not always parallel to the 
ground!), which is perpendicular to the vertical line defined by a plumb-line. 

The style, planted in the table is directed according to the north-south axis and points towards the celestial pole. The 
angle formed between the style and the table is equal to the latitude of the location. The opposing angle, at the end 
of the polar style is equal to the co-latitude (90° - latitude) of the location. Thus, for a horizontal sundial located at 
the North Pole, the style will be vertical, whereas at the equator, the angle will be null and the style will be horizontal. 

 

Limits of illumination 

A horizontal sundial gives the hours of the morning and of the afternoon. In the countries of high latitude, it may be 
illuminated all 24 hours of the day, during the summer.  

In the Northern hemisphere, the sun reaches its highest declination on the summer solstice (21st of June) and the 
resulting shadow is at its shortest. During the winter, it is the opposite, with the lowest declination reached at the 
winter solstice (December 21st) where the shadow reaches longest. 

During the equinoxes, the extremity of the style projects a shadow on a line oriented exactly East-west. 

For a location in the tropics, the declination of the sun may be greater than the latitude. In this case, the sun passes 
over the zenith and generates an inverted shadow. For such a location, the declination lines are drawn on each sides 
of the style. At noon, for a declination equal to the latitude, the sun does not generate any shadows! 
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Construction 

 

The generated table of coordinates provides information for 
graphical construction of the various lines that make up the 
horizontal sundial. Coordinates for the hour lines, declination lines 
and analemma are tabulated using both Cartesian (x and y in 
millimeters) and polar format (radius in millimeters and angle in 
degrees).  

Cartesian coordinates are given in millimeters from the origin at 
point A with the X-axis towards the right and the Y-axis towards the 
top.   

Polar coordinates are given with respect to the fixed-point B (pole) 
with the radial coordinate given in millimeters and the angular 
coordinate given in degrees with a convention of positive angles 
defined counterclockwise from the horizontal  

 

Installation 

 

Horizontal sundial at the Lowell observatory in 
Flagstaff (AZ, USA) – Photo FB. 

 

Horizontal sundials can be found on small columns in 
gardens and squares. The table is often polygonal or 
circular. 

The sundial must be oriented along the meridian line 
(M), its style pointing to the pole (P): 

The point A must be placed closer to the pole 
compared to point B. Contrary to what some may 
think, the style is not pointing to the Sun, but to the 
North pole in the northern hemisphere or to the 
South pole in the southern hemisphere. 

A horizontal sundial is easily reached by the public, 
and therefore may be damaged. Its pointing style may 
also constitute a hazard. So it is recommended to 
leave some space around. 
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The vertical direct south sundial 

Geometry of the sundial 

This sundial is installed on a vertical wall. In the Northern hemisphere, it faces south and in the Southern hemisphere 
it faces north.  

The style points towards the ground and forms an angle with the plate equal to the co-latitude (90° - latitude). 

The solar noon line is vertical and superimposed on the sub-style line. 

 

Limits of illumination 

The sundial is lit as soon as the sun is above the horizon and more south (more north in Southern hemisphere) than 
the east-west line. If it is installed in the tropics, there will be a period of the year where it is not lit as the sun is 
behind the wall. It may be possible to install a complementary sundial on the other side of the wall. 

At the summer solstice, when the sun is at its highest point in the sky, the shadows are long and extend far from the 
base of the style. On the contrary, during the winter, the shadows remain close to the base of the style. 

Construction 

 

The generated table of coordinates provides information for 
graphical construction of the various lines that make up the vertical 
direct south sundial. Coordinates for the hour lines, declination lines, 
and analemma are tabulated using both Cartesian and polar format. 
Cartesian coordinates are given in millimeters from the origin at 
point A. Polar coordinates are referenced to the fixed-point B (pole) 
with the radial coordinate given in millimeters and the angular 
coordinate given in degrees with a convention of positive angles 
defined counterclockwise from the horizontal. 
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Installation 

A vertical direct south can be combined with a horizontal 
sundial with a single style to create a double sundial. 

This type of sundial is often associated with a meridian sundial 
with an analemma curve that provides the equation of time 
and longitude correction to allow reading of mean time. 

The vertical direct south sundial is the most common type of 
sundial. It is usually seen on the bell tower of a church, on the 
facade of a public building, or on private homes.  

The sundial must be installed exactly facing south (north in 
Southern hemisphere) and the style perfectly aligned with the 
Earth’s rotation axis. 

  

Vertical direct south sundial, Aix-en-Provence, 
France – Photo FB. 

  

Vertical sundial for the city of Meknès, Morocco, of 
latitude 33° 53’ north. The June solstice arc is at the 
bottom part (Summer), the December arc is at the top 
part (Winter). Hours go from the left (morning) to the 
right (afternoon). The sundial is due south. 

Vertical sundial for the city of Cape Town, South Africa, 
of latitude 33° 55’ south. The June solstice arc is at the 
top part (Winter), the December arc is at the bottom 
part (Summer). Hours go from the right (morning) to the 
left (afternoon). The sundial is due north. 

 

  



Reference manual of Shadows Pro – © François Blateyron – page 62 

The vertical declining sundial 

Geometry of the sundial 

The vertical declining sundial can be installed on any vertical surface not aligned with one of the cardinal directions. 
That is all the orientations between those of a vertical direct east and a vertical direct west dial, as well as orientations 
between the vertical direct south and the vertical direct north dial. An azimuth of 0° will give a vertical direct south 
(north in Southern hemisphere) dial. An azimuth of 90° east will give a vertical direct east sundial. Lastly, an azimuth 
of 180° will give a vertical direct north (south in Southern hemisphere) dial. 

The vertical declining sundial provides very interesting lines for an azimuth between 20° and 60° (below, 30° West). 

 

Limits of illumination 

The plate of the vertical declining sundial is illuminated when the sun is above the horizon and passes in the semi-
circle centered on the wall declination (d-90° to d+90°) 

A sundial declining towards north (south in the Southern hemisphere) will be illuminated shortly in the morning and 
again shortly in the evening, but not during the day. In winter, the sundial may not be illuminated at all. 

Construction 

 

The generated table of coordinates provides information for 
graphical construction of the various lines that make up the 
vertical declining sundial. Coordinates for the hour lines, 
declination lines and analemma are tabulated using both 
Cartesian and polar format. Cartesian coordinates are given in 
millimeters from the origin at point A.  Polar coordinates are 
referenced to the fixed-point B (pole) with the radial coordinate 
given in millimeters and the angular coordinate given in degrees 
with a convention of positive angles defined counterclockwise 
from the horizontal. 

For dials with a large declination angle, point B is projected far 
from point A, and the polar coordinates are not given. 
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In the Northern hemisphere, when the style is on the right 
side of the noon line, it is declining towards the west and is 
illuminated mainly in the afternoon. If the style is on the left 
side, it is a morning sundial as it declines towards the east. In 
the Southern hemisphere, the situation is reversed. 

Left, declining sundial on the St Cross church in Oxford, 
United Kingdom. Photo FB. 
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The vertical direct west sundial 

Geometry of the sundial 

The vertical direct west sundial faces precisely west. Its style is rectangular with the upper edge oriented towards the 
celestial pole. Point B is cast to infinity and hour lines are parallel to each other and to the sub-style. 

 

Limits of illumination 

The vertical direct west sundial can only give hours from local noon to the sunset. Around noon, the shadow is oblique 
and its end is projected to infinity. Furthermore, the accuracy of readings just after noon is not very good due to 
construction and installation tolerances. 

Construction  

The style is usually built as a large rectangle with a notch to locate the shadow on the declination lines. Sometimes 
the style is just a perpendicular rod fixed at point A. Points B* are arbitrary and defined by the length of the truncated 
style (see Dimensions dialog box). 

 

The generated table of coordinates provides information for 
graphical construction of the various lines that make up the 
vertical direct west sundial. Coordinates for the hour lines, 
declination lines, and analemma are tabulated using both 
Cartesian and polar format. Cartesian coordinates are given in 
millimeters from the origin at point A.  Polar coordinates are 
referenced to the fixed-point B (pole) with the radial coordinate 
given in millimeters and the angular coordinate given in degrees 
with a convention of positive angles defined counterclockwise 
from the horizontal. 
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Installation  

 

The sundial must be installed on a vertical wall facing the west. The 

most important part of the style is its end that can be realized as an 

eye piece (disk with a hole) or by a simple rod with or without a 

portion of the polar style at its end. 

Left, direct west sundial painted on Albi cathedral, France –  
Photo FB. 

The vertical direct east sundial 

Geometry of the sundial 

The direct east sundial faces precisely east. Its polar style is parallel to the sundial plate and to the Earth’s rotation 
axis. Point B is rejected to infinity and hour lines are parallel to each other. This is why, the style of this sundial is 
usually a rod planted on point A. The whole sundial plate is included in the meridian plane.  

 

Limits of illumination 

The vertical direct east sundial can only give hours from sunrise to the local noon. Around noon, the shadow is oblique 
and its end is projected to infinity. Consequently, the accuracy is not very good due to construction and installation 
tolerances. 

Construction 

The style is usually built as a large rectangle with a notch to locate the shadow on the declination lines. Sometimes 
the style is just a perpendicular rod fixed at point A. Points B* are arbitrary and defined by the length of the truncated 
style (see Dimensions dialog box). 
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The generated table of coordinates provides information for 
graphical construction of the various lines that make up the vertical 
direct east sundial. Coordinates for the hour lines, declination lines 
and analemma are tabulated using both Cartesian and polar 
format. Cartesian coordinates are given in millimeters from the 
origin at point A.  Polar coordinates are referenced to the fixed-
point B (pole) with the radial coordinate given in millimeters and 
the angular coordinate given in degrees with a convention of 
positive angles defined counterclockwise from the horizontal. 

 

Installation 

The dial is installed on a vertical wall facing east. The style can be a simple rod planted perpendicular to the dial plate 
at point A. But a bar can also be installed parallel to the dial plate, oriented towards the Celestial Pole. 

 

Direct east sundial in the Invalides, Paris – Photo FB. 

The meridian dial 

A meridian dial is a variant of a classical sundial, often horizontal or vertical. Large horizontal meridian dials can be 
found on some churches, while vertical meridian dials are more common and usually have an analemma curve around 
the noon line. 

A meridian dial aims at providing mean time around noon; this is why it provides time usually 30 minutes to a 
maximum of one hour before or after noon. 



Reference manual of Shadows Pro – © François Blateyron – page 67 

    

Oxford Paris –Crillon hotel Dijon – Palace of the Dukes Montbéliard 
Pré la rose park 

Several large horizontal median dials can be found adorning Italian or French churches (e.g., the famous Saint-Sulpice 
church in Paris with the “rose line”). 

Shadows makes it possible to create a meridian dial from any sundial with polar style. To do so, check the option 
Make it a meridian sundial in the selection of the type of sundial with polar style during the creation process. It is 

also possible to choose  Limit hours of the sundial in the Drawings menu. 

The meridian sundial option will limit hours to between 11 h and 13 h. All of the other options can be used. 
Recommended options on meridian sundials are to draw hour lines with a span small enough to provide accuracy, 
for example every 5 minutes, and to draw the analemma curve around noon with Zodiacal symbols, or dates to help 
users to read the difference on the correct side of the curve. 

Graph of visibility hours of the meridian sundial 

This graph provides the time, expressed in civil time, of the sun’s passing of the meridian for a given date. It allows 
one to know at what civil time the shadow of the style will be visible on the meridian sundial, and especially on the 
analemma curve. The longitude correction is already included in the curve. The value of the equation of time can be 
deduced by the difference between the curve and the 12 h line. 
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1. Solar noon – hour of sun’s passing the local 
meridian. 

2. Curve of 11h45 in solar time  

3. Curve of 12h15 in solar time 

4. Curve of 11h40 in solar time (i.e., approx. when 
the shadow enters the meridian dial) 

5. Curve of 12h20 in solar time (i.e., approx. when 
the shadow leaves the meridian dial) 

 

The equatorial sundial 

The equatorial sundial is a special case of the inclining dial, for which the layout of the hour lines becomes very simple. 
Indeed, the face of this dial is in the plane of the celestial equator (extension of the terrestrial equator to infinity). 

This plane makes an angle with the horizontal of 90°- (colatitude). 

The style is perpendicular to the plate and directed towards the celestial pole. The shadows are rectilinear and move 
oppositely to the sun at the same speed. Hour lines are thus regularly spaced every 15° (360°/24 h). Declination lines 
are always circles. 

This type of sundial is seasonal because when the sun is above the celestial equator, it illuminates the upper side of 
the dial, whereas during the rest of the year, it illuminates the lower side. Around the equinoxes, this dial is lit edge-
on all day long, and it is quite impossible to read the hour on it.  

 

 

 

Upper side. 
 The polar style points towards the pole. 

Lower side 
The polar style points opposite to the pole. 



Reference manual of Shadows Pro – © François Blateyron – page 69 

Key: P, direction of the pole; M, meridian line; H, horizontal plane; A, foot of the polar style; C, end point 
of the polar style; s, shadow of the style on July 21st at 4 pm for the upper face, and on January 21st at 10 
am for the lower face; x, end point of the shadow on the sundial. 

 

 

 

Left: one of the three equatorial sundials made in 
white marble, visible at the Forbidden City, Beijing, 
China. 
A single style emerges on both sides to allow 
reading time all year long. 

Photo FB. 

 

 

 

 

The polar sundial 

Geometry of the sundial 

The polar sundial plate is parallel to the pole axis and is facing the intersection point between the celestial equator 
and the local meridian. The inclination of the sundial plate is equal to the latitude. Therefore it is the complementary 
sundial of the equatorial sundial. 

The hour lines of the polar sundial are all parallel and oriented towards the pole. 

The style can be a simple rod placed at point A perpendicularly to the sundial plate, or it can be a rectangular style 
place between the two points B*. It is the same kind of style as for a vertical direct east or west sundial.  

Limits of illumination 

The polar sundial (non-declining) is illuminated throughout the year and as long as the sun is over the horizon, just 
as for a horizontal sundial. 

Construction 

The y-axis is oriented along the polar axis, towards the pole. 
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Polar sundial with analemma curves in order to 
provide civil time. Created by Dan O'Neal for the 

city of Santa Avelina in Guatemala. 

The declining polar sundial 

This variant of a polar sundial has its plate rotated around the polar axis by a given angle. If this angle is 90° towards 
the west, it gives a normal direct west sundial. 

The declining polar sundial can be used to create multiple sundials on the sides of a polyhedron cylinder oriented 
along the polar axis. For example, a cylinder with eight sides can sport a direct south polar sundial, two polar sundials 
declining by 45° east and west, two polar sundials declining by 90° east and west, and two polar sundials declining by 
135° east and west. The latest declines by 180° and is never lit by the sun. 

 

 

 

Above left: An example of a multiple polar sundial on a 
hexagonal cylinder. Imagine that each sundial is folded 
on the sides of a cylinder. Declinations are 60°, 120°, and 
180° around the polar axis. 

 

Above right: a multiple octogonal polar sundial, with 
declinations of 0°, ±45°, ±90°, ±135° et 180°. 
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The declining and inclining sundial 

This sundial is installed on a plane that is neither vertical nor horizontal (inclining) and that do not face the local 
meridian (declining). Declining and inclining sundials are quite rare because such supports are not common in 
architecture. They can be installed, for example, on chamfers on a church, or on rocks. Some angles may be 
interesting as they generate nice layouts with hour lines and declination lines. 

Such sundials are sometimes found on multiple sundials. For example, a polyhedral sundial (e.g., with ten sides) may 
have such inclined and declining sundial on sides that are neither horizontal nor vertical.  

Note: equatorial and polar sundials are examples of inclined sundials. 

 

 

This sundial is characterized by both inclination I 
measured from the horizontal plane and by its 
declination D measured from the east-west line M’. 

 

Changing the declination and the inclination 

Go to the Configuration menu >  Change the sundial’s orientation / inclination… The modification is applied in 
real-time so that you can see how changes affect the layout. 

 

A vertical declining sundial can be changed to another 
declination, but not in inclination/declination. 

A general plan sundial can be oriented and inclined in both 
directions. 
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The spider sundial 

The spider sundial is built on the same basis as a sundial with polar style. It can be inclined and declining. Its name 
comes from the layout that looks like a spider web due to oscillating hour lines and circular declination lines.  

Hour lines are drawn with the equation of time inclined. They are unfolded to allow a linear reading depending on 
the date from the inner circle to the outer circle. The style must be a polar style, long enough to allow the reading on 
all circles.  

 

The hour is read at the intersection between the 
circle corresponding to the date and the shadow 
of the style. The exact value is interpolated 
between the two closest hour lines. 

By default, the inner circle corresponds to the 
summer solstice. The blue circle in the middle is 
the winter solstice, and the outer circle is again 
the summer solstice. 

The length of the shadow is not important here. 
It is only the intersection of the shadow with the 
circle corresponding to the current date that 
matters. The hour is read on this intersection 
between the closest undulating lines. 

This type of sundial does not allow one to display other types of hour lines (such as Italic hour lines) 

When the shadow of the style is visualized on the sundial, a circular marker is drawn to help read the time. This 
sundial makes it possible to directly read civil time, as on your watch. 

Options for the circles are the same as for declination arcs on a classical sundial (by date, Zodiac or declination). 

 

Note: another type of spider sundial exists, with a gnomon, which is different from this one and which is not available 
in Shadows. 

Spider sundials are available in Shadows Expert or Shadows Pro.  
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Analemmatic sundials 

Analemmatic sundials are a family of sundials that have a mobile style moving with the date. An analemmatic sundial 
is made of a large ellipse labeled with hour points and a date line in the middle of the sundial where the style is placed. 

The most common analemmatic sundial is horizontal. It is usually drawn on the ground as a large ellipse with the role 
of the style played by someone standing at the appropriate position on the date line. By holding a hand overhead, a 
shadow is cast that intersects the ellipse at a point where the hour is read. 

History 

The first analemmatic sundial installed in France and probably the World’s first analemmatic sundial is at the Brou 
church. It is dated from 1513 and was first described in 1644 by Vauzelard, who is now considered as the theoretician 
of analemmatic sundials. A very few analemmatic sundials have been created before 1950: Dijon (1827), Besançon 
(1902), Montpellier (1927), Avignon (1931). 

Position of the style 

In an analemmatic sundial, the style is a straight rod perpendicular to the sundial plate, positioned at the correct date 
on the central date line. The date line is labeled with date or declination or zodiacal symbols. On a small analemmatic 
sundial, the date line is usually a groove allowing the style to slide or a series of holes to accept the style at the correct 
date. 

Reading time 

If the shadow is long enough and intersects the ellipse, solar time is directly read at the intersection. In case the 
shadow is too short, it must be extended to the ellipse (see below). 

 

Correct reading of time:  
by extending the shadow to the ellipse 

 

Incorrect reading: by drawing a line  
from the center to the shadow end 

Contrary to what can be seen on the Brou sundial, it is not possible to draw an analemma curve on the date line and 
place the style on this curve to get the mean time. This is, therefore, why Shadows does not allow the display of mean 
time on an analemmatic sundial. 

The ellipse 

As latitude increases, the ellipse tends to be more circular, and the date line tends to be shorter. At the pole, an 
analemmatic would be circular with a date line as a single point, and would be identical to an equatorial sundial. On 
the equator, the analemmatic sundial is reduced to a single line scaled with hour points, and the date line is maximum. 

Analemmatic sundials are available only in Shadows Expert and Shadows Pro. 
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The horizontal analemmatic sundial 

The minor axis of the ellipse is aligned on the meridian line (north-south), and its major axis is aligned on the east-
west line.  

 

Analemmatic sundial of the promenade du 
Peyroux in Montpellier. Photo FB. 
 

The use stands on the date line, at the 
position corresponding to the date and he 
raises his arm vertically above him. Time is 
read by extending the shadow to the ellipse. 

 

 

Depending on the location, the eccentricity and the length of the date line are changing. Such horizontal analemmatic 
sundial installed at the pole would be equivalent to a classical equatorial sundial; the date line would be a single point 
and the ellipse would be a perfect circle. On the contrary, installed on the equator, the date line would be the longest 
and the ellipse would be a simple line, oriented east-west. 

   

  

  

Horizontal analemmatic sundial 
for Berlin, Germany (52° 30’ N) 

Horizontal analemmatic sundial 
for Bangkok, Thailand (13° 45’ N) 

 

The vertical analemmatic sundial 

Two different types of vertical analemmatic sundials are offered: the vertical direct south and the vertical declining.  
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On a declining sundial, the date line is inclined and the ellipse is stretching with the declination. With a declination of 
90° (direct east or west), the ellipse is just a line perpendicular to the date line and the date line makes an angle with 
the horizontal plane equal to the local latitude. 

   

 

 

Vertical direct south analemmatic sundials are available in Shadows Expert and Shadows Pro. Vertical declining 
analemmatic sundials are available in Shadows Pro. 

Options for the date line 

The date line can be configured with several scales. Zodiac signs, date of the month or declination of the sun, as on 
declination lines in a classical sundial. 

     

Vertical direct south analemmatic sundial Vertical declining analemmatic sundial (20° east) 
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Zodiac signs Zodiac signs and 
decants 

First day of each 
month 

First and 16th day of 
each month 

Declination of the 
Sun 

 

The armillary ring 

This sundial is drawn in the inner surface of a semi-cylinder whose axis is inclined along the Earth’s rotation axis. This 
sundial is a polar, cylindrical sundial. Its style is its axis (usually a metal rod). Often a marker is installed in the middle 
of the axis in order to see the shadow moving with the sun declination. The marker can be a small sphere. 

 

Hour lines are all parallel to each other and equally 
spaced. They mark the sun’s hour angle. 

Declination lines are parallel circles crossing hour lines 
perpendicularly. 

When the radius of the cylinder is large and the 
cylinder height is small, it leads to an armillary ring, 
the equatorial band of an armillary sphere. 

This sundial gives the same indications as a planar 
polar sundial.  

 

The armillary ring sundial is available in Shadows 
Expert and Shadows Pro. 

 

 

 

Left: an armillary ring (polar cylindrical sundial) in 
Geneva (Switzerland). 

Hour scales are marked with Roman numerals at 6h 
and 12h.  

Parallel lines mark the sun’s declination every 5°.  

An eyepiece casts a spot of light on the cylindrical 
surface to read the time. 

 

Below: the equivalent drawing in Shadows. The width 
of the band is calculated from the cylinder radius. It 
can be stuck on the internal surface of the cylinder, 
centered under the eyepiece. 
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The cylindrical polar sundial without style 

It is a cylinder cut through its middle and oriented along the Earth rotation axis.  

 

This sundial does not have any style. The shadow is cast by one 
of its lateral edges. In the morning, time is read by the shadow 
cast by the right edge of the cylinder (left in the Southern 
hemisphere). In the afternoon, the shadow is cast by the other 
edge. 

Hour lines are swept by the shadow twice during the day, once 
by each edge.  

 

This sundial is available in Shadows Expert and Shadows Pro. 

 

 

 

 

Example for the Northern hemisphere, drawn in the polar 

plane:  

At sun rise, the shadow of the right edge is cast on the left 

edge, then the limit between light and shadow falls into 

the cylinder as the sun rises in the sky.  

At noon, the sun is directly above the cylinder and no 

shadow is cast. The cylinder is fully lit. 
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In the afternoon, the sun starts to go down to west and 

the shadow is produced by the left edge.  

The shadow goes down into the cylinder then rises on the 

right side towards 18h solar hour, where the cylinder is 

fully in the shadow. 

In the Southern hemisphere, the process would be reversed with the sun moving from left to right. 

 

 

When a mark is installed on the East and West edges (here a small ball), 

we can then be drawn declination arcs. The position of solstices 

depends on their distance from that mark. They coincide at the edges. 

The shepherd’s dial 

This sundial is drawn on the external surface of a cylinder held vertically. The style is perpendicular to and can be 
rotated around the cylinder axis. When using this dial, rotate the style to align it with the date, then rotate the whole 
cylinder to have a vertical shadow (the style is then facing the sun direction). The length of the shadow gives the time. 
It is important that the bottom edge of the style is exactly at the top of the network of lines. 

 

The shepherd’s dial uses the sun’s altitude instead of its hour 
angle to indicate the time, in contrast to other types of sundials. 

The shepherd’s dial is usually made from a wooden cylinder that 
can easily be stored in a pocket. It has a ring on the top with a 
small rope to hang it vertically. 

It can be used throughout the year but it requires the date to be 
known in order to rotate the style correctly. It can only give the 
solar time.  

Vertical lines are drawn by default for zodiac signs changes. They 
are equivalent to declination lines and can be configured in the 

Drawings menu >  Properties of declination lines... It is 
possible to scale the lines by date. 

This sundial is available in Shadows Expert and Shadows Pro. 
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Drawing in Shadows.  

The red lines correspond to the bottom edge of the style. 

 

Shepherd sundial made with ivory  

Museum of Sciences, Oxford, UK 

The vertical cylindrical (external) sundial 

This sundial is drawn on the external surface of a vertical cylinder and has a style planted perpendicularly to the 
surface. The perpendicular style can be declining. That is, it can face any azimuth. However, the polar style needs to 
intersect the cylinder surface at point B. The more declining the dial, the more shifted is the layout. 

 

Direct south (not declining) 

 

Declining by 20° towards West 

 

This sundial can be installed on a round tower of an old house or on a castle. 

This sundial is available only in Shadows Pro. 

The vertical cylindrical (internal) sundial 

This sundial is drawn on the internal surface of a vertical cylinder. The style is made by an eyepiece installed on the upper 

face, right on the cylinder axis. 
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The sundial can be drawn on a half-cylinder, cut vertically along the east-west 

plane, or on a transparent cylinder, in order to ensure that edges will not cast a 

shadow on the layout. 

The vertical line of the solar noon and the cylinder axis have to be oriented on the 

meridian plane. The eyepiece will cast a sport of light on the layout. 

This type of sundial can create a nice layout when colored between the declination 

lines (see in the Sundial Layout preferences) 

 

This type of sundial is available only in Shadows Pro. 
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Bifilar sundials 

Bifilar sundials constitute a family of dials where the "style" is made of two orthogonal threads tight above the sundial 
at two different heights. The shadow cast by the threads is a cross. This type of sundial was discovered by German 
mathematician Hugo Michnik in 1922. Since then, a number of variants have been explored, like the declining vertical 
bifilar sundial. 

One of the threads is called the meridian thread because it is contained by the local meridian plane. The other thread 
is called the transversal thread and is always perpendicular to the meridian thread. 

The furniture of a bifilar sundial is similar to the one of a classical sundial: hour lines converge to a single point and 
diurnal arcs are hyperbolas. One can consider that the point where hour lines converge is equivalent to the 
attachment point of the polar style in a classical sundial (point B). Similarly, the point located right below the thread 
intersection is equivalent to the attachment point of the perpendicular style in a classical sundial (point A). 

When the height of each thread is properly calculated, hour lines are spaced regularly (every 15°, as in an equatorial 
sundial) resulting in an equiangular bifilar sundial. In this case, the height of the transversal thread is calculated from 
the height of the meridian thread and the latitude. 

In case the two threads are at the same height, we obtain the same layout as with classical sundial with a polar style. 
The crossing point of the two threads coincide with the end of the perpendicular style. This alternate type of style 
may be a good solution to replace the polar style that may cause injuries when the sundial can be reached by the 
public.  

Bifilar sundials are available only in Shadows Pro. 

The horizontal bifilar sundial 

This horizontal sundial has one thread oriented north-south (meridian thread) and another thread, oriented east-
west (transversal thread). 

The center of the dial (where hour lines converge) is slightly shifted towards the south, compared to the point located 
beneath the crossing of threads. The noon line is oriented north-south as in a classical horizontal sundial. 

If the sundial is equiangular, the transversal thread lays under the meridian thread and the hour lines are equally 
spaced every 15°. 

The horizontal bifilar sundial is an excellent alternative to the horizontal sundial when a style with a sharp point might 
create a hazard for the public, while it offers a similar drawing. 

 

 

 

The vertical declining bifilar sundial 

The general vertical bifilar sundial has a vertical thread, parallel to the wall (meridian thread) and a horizontal thread 
(transversal thread), oriented east-west when the sundial is not declining. 
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The interesting property of an equiangular vertical bifilar sundial is that threads are no longer horizontal and vertical, 
but inclined (yet they remain orthogonal to each other). The meridian thread is above the sub-style line. Another 
bizarre property is that the noon line is not vertical. Hour lines are regularly spaced every 15°. 

 

Vertical declining bifilar sundial,  
with horizontal and vertical threads 

 

Vertical declining bifilar sundial, 
with equally spaced hour lines. Threads are inclined. 
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Gallery of sundials made by users 

These two pages show a selection of sundials made by users of Shadows. They have manual skills such as painting, 
engraving, drawing, etc. and they found the complementary skills they missed in Shadows. Other sundials can be 
seen on www.shadowspro.com/en/sundials-made-by-users.html 

  

  

  

  

 

http://www.shadowspro.com/en/sundials-made-by-users.html
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PART 3 – ASTROLABES 

 

Introduction to astrolabes 

Note: please refer to the glossary to find the definitions of technical terms used in this text. 

An astrolabe is a representation of the celestial sphere on a 
plane. It is an astronomical calculator used for example to 
find hours of setting or rising of the sun or of a star, or to 
convert coordinates of a star from a coordinate system to 
another (horizontal, equatorial, ecliptic), or to find azimuth, 
altitude, right ascension, declination, etc. 

The origins of the astrolabe are not very precise; We know 
the early contributors who wrote the first treatises on the 
astrolabe, between the 3rd and 6th century, and we also 
know that Ptolemy wrote an essay on the stereographic 
projection in his book planisphaerium (published around the 
year 140), inspired by work from Hipparcos (2nd century 
B.C.). Literature around astrolabes really flourishes between 
the 9th and 12th centuries, especially with the numerous 
translations of ancient Greek and Arabic treatises, and also 
with the conquest of the south of Europe by Arabs, leading 
to the famous Spanish-Arabic school whom Arzachel (Al 
Zaqali) is the most famous member. 

 

A French astrolabe from the 17th century at the 
Smithsonian Air and Space Museum in 
Washington. 

The astrolabe spreads between the 12th and 16th century, on the one hand towards Orient and Persia, and on the 
other hand across the rest of Europe, especially Paris, Germany and Netherlands where artisans and goldsmiths, who 
were not always scientific or astronomers, made beautifully decorated astrolabes. They used to replicate existing 
astrolabes and sometimes they introduced errors. One of the most famous astrolabe makers is Arsenius from 
Belgium. The 17th century marks the beginning of astrolabe clocks, such as the famous clock in Prague. 

Today, we can see astrolabes in museums, observatories and planetariums, such as the Museum of Arts et Métiers 
or the Louvre in Paris, observatories of Paris or Greenwich, museums of the history of science in Geneva, Oxford or 
Firenze, maritime museums in Madrid or Barcelona, or the Adler planetarium in Chicago, etc. 

The astrolabe had a strong influence on various arts and has become the symbol of exploration and scientific 
knowledge. Examples can be seen in painting, sculpture and even on stamps, money and watches, on the page 
Astrolabes in arts. It is also not so rare to see an astrolabe and an armillary sphere in movies when a scientific lab is 
shown, such as with Dumbledore in Harry Potter or in the travelling bag of Guillaume de Baskerville in The name of 
the rose. 

  

https://www.shadowspro.com/en/astrolabes-in-arts.html
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Astrolabes usually have drawings on their two faces (front and the back) whose purpose may be different and/or 
complementary.  

The front of the astrolabe 

The front of an astrolabe is constituted with the mater (2) on which several mobile disks and accessories are installed. 
The mater can be suspended by a ring called the throne (not drawn here). The limb (1) is around the mater and is 
thicker. The mater, throne, and limb are fixed with respect to each other. The mater has a hole in its center. Plates 
can be installed on the mater that are designed for a given latitude. An astrolabe is usually provided with at least 
three plates in addition to the mater, which also contains the same drawings. The Rete (3) is installed on top of the 
plate, then sometimes a Ruler (6). 

 

 

1. The Limb – is around the mater and scaled in degrees (90° 
quadrants) and in hour angles. It shows north, south, east and 
west points and is usually used with the ruler. 

2. The Mater – can have the same drawings as a plate. The 
three circles are the two tropics and the equator. The 
drawings inside the horizon are azimuth and altitude arcs 
(almucantarats). 

3. The Rete – can be rotated around the central axis. It is 
usually decorated with fine and rich details. 

4. The Ecliptic circle – is scaled in ecliptic longitude and 
displays Zodiac symbols. It is part of the Rete. 

5. Stars of the celestial sphere – can be drawn directly or may 
be replaced by small pointers attached to the Rete. 

6. The Ruler – rotates around the center and points to a scale 
on the limb. 

The back of the astrolabe 

The back contains several drawings and an Alidade. One usually starts by using the back of the astrolabe before using 
the front (for example to find the sun's altitude with the back and knowing the date, assess the solar time on the 
front). 

 

7. Scales in degrees – to measure altitudes or angles with 
the alidade. 

8. Scales in ecliptic longitude – with Zodiac symbols. 

9. Calendar – to find the ecliptic longitude of the sun for a 
given date. 

10. Equation of time – depending on the date. 

11. Unequal hours. 

12. Shadow square – to calculate distances and heights. 

13. Alidade – used for sighting through with a pinhole on 
each end. 
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Some astrolabes may provide other drawings on the front or the back such as the Qibla for several locations, equal 
hours, etc. 

Different types of astrolabes 

Across time, astrolabes have been improved and have evolved into many types: 

 

Classical Planispheric astrolabe 
 

Universal astrolabe 

 

Mariners astrolabe 

 

Muslim Planispheric astrolabe 

 

Quadrant astrolabe 

 

Rojas astrolabe 

All these astrolabes are described in D'Hollander’s book (see bibliography). 

The current version of Shadows offers the Mariners astrolabe, the planispheric astrolabe and the Universal astrolabe. 

The stereographic projection 

The Stereographic projection, which is used in planispheric astrolabes, projects a point of a sphere onto the equatorial 
plane, as seen from one of the poles. For an astrolabe, the center of projection is the South pole for the Northern 
hemisphere, and the North pole for the Southern hemisphere. 
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The center of projection (1) is the South pole. The point P on the 
celestial sphere (2) with a declination d is projected onto the 
equator as point P' (3). Its distance to the center is measured by 
x. This projection keeps the other coordinate, the right ascension 

a. The polar coordinate of point P' will be (x, ). 

The lower the declination, the farther the projected point from 
the center O. This is the reason why the projection is limited to 
the southern tropic. 

 

The stereographic projection has interesting properties for drawing maps: 

• The projection of any circle of the sphere is also a circle on the projection plane 

• The projection does not alter angles 

also: 

• The equator is projected onto itself as, by definition, it lays on the equatorial plane 

• All circles of a given declination are projected as concentric circles with center O 

 

 

1. The equatorial circle – is projected onto 
itself. 

2. The Tropic of Cancer – is projected onto a 
circle inside the equatorial circle. 

3. The Tropic of Capricorn – if projected as a 
circle outside the equatorial circle. It limits the 
drawings of the astrolabe. 

4. The Zenith point – is projected in 5 on the 
north-south line of the astrolabe, far from the 
center when the latitude is low. 

6. The North Pole – is projected at the center 
of the astrolabe. 

7. The local horizon – is projected as a large 
circle shifted from the center. 

8. Altitude circles above the horizon – are 
projected as shifted circles called 
almucantarats. 
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The Planispheric astrolabe 

The planispheric astrolabe is so-called because it is the projection of a sphere on a plane. It uses the stereographic 
projection, which projects the sphere onto the equatorial plane from a pole. 

 

1. North Pole – is at the center of the astrolabe. 

2. Zenith – which depends on the latitude for which 
the plate is designed. 

3. Circle of the Tropic of Cancer 

4. Equatorial circle 

5. Circle of the Tropic of Capricorn – that defines the 
limits of the astrolabe. 

6. Horizon circle. 

7. Civil twilight arc. 

8. Nautical twilight arc. 

9. Astronomical twilight arc. 

10. Altitude circles above the horizon – also called 
Almucantarats. 

11. Azimuth circles. 

 

From left to right, plates designed for the following locations: Madras, India, latitude 13°, Alexandria, Egypt, latitude 
31°, Delft, The Netherlands, latitude 52°, Tromsø, Norway, latitude 69°. 

 

Rete of the astrolabe 

The rete of an astrolabe represents the ecliptic circle and the celestial sphere with stars and constellations, on a 
transparent disk or a metallic ornamented support that is superimposed on the plate. The ecliptic circle is scaled with 
the sun’s ecliptic longitude and with zodiac symbols. 

The rete can be drawn transparent to allow a clear reading of the plate underneath. Old retes are made in metal with 
pointers for stars. Shadows can draw both types of retes. 

 

Opaque rete 

 

Transparent rete 
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The transparent version can be used if you want to print it on Plexiglas or on a transparent film. The opaque version 
is closer to what can be seen on old astrolabes with pointers for stars as below: 

   

 

Examples of ancient retes 

   

   

Photos, © National Maritime Museum, Greenwich, UK 

Realistic Rete in Shadows 

By default, Shadows draws a geometric rete. With version 5.2, it is possible to draw a realistic rete that recalls the 
ones seen on ancient astrolabes, as seen above. 
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Rotating the Rete 

 

The rete can be rotated on screen with the mouse by 
clicking on the area around 270°. You can then move 
it to align a given position on the ecliptic circle with 
the limb or the scales on the plate. 

The rete can also be rotated using arrows on the 
keyboard, up arrow  and down arrow  and holding 
the CTRL key pressed.  

The rotation is performed by a 1-degree increment. 

 

 

Besides the manual rotation with the mouse or keyboard keys, it is possible to show the position of the Rete for the 
current instant or for a given date and time.  

By double-clicking on the sensitive zone at 270°, or by clicking on the  icon, a dialog box is displayed: 

 

The choice Rotation in real-time uses the PC clock to 
display the rete, the stars and the sun as they should 
be. It is necessary to select a real location to 
configure the longitude. 

The choice Rotation animated for a given date and 
time rotates the rete either by increasing the date, 
or the time. 

Configuring the drawing of the astrolabe 

 Display the front side of the astrolabe 

 Display the back side of the astrolabe 

 Change the diameter of the astrolabe and the thickness of the limb 

 Change the latitude of the plate 

On the front 

 Display the limb 

 Display the altitude circles and the azimuth arcs on the plate 

 Display the equator and Tropic circles on the plate 

 Display unequal hours 
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 Display the opaque rete 

 Display the transparent rete 

 Display stars and constellations  

 Display the ruler on the astrolabe 

 Change colors of elements 

Other options can be accessed from the Drawings menu, in particular scaling options for the limb and the plate.  

Stars can be displayed from up to magnitude 1 to up to magnitude 4, and star names can be displayed. 

   

star up to magnitude 2 star up to magnitude 4 star names displayed 

Star pointers can be displayed on the opaque rete, as on ancient astrolabes. 

On the back 

 Display the back  

 Display a calendar on the limb 

 Display the arcs of unequal hours 

 Display the shadow square 

 Display the equation of time 

 Display the alidade 
 

 

The calendar drawn on the limb is scaled from the 
inner edge to the outer edge with the following 
indications: 

• months 

• days 

• zodiac signs 

• sun’s ecliptic longitude 

• quarters of circles scaled in degrees 

 

The alidade can be scaled with different scales, two different uses: 
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 Scale in degrees of altitude to read arcs of 
unequal hours in function of the date pointed on the 
calendar on the limb. 

 

 Scale in minutes to read the equation of time in 
function of the date pointed on the calendar on the 
limb. 

 

The planispheric astrolabe is available only in Shadows Pro. 

Astrolabe for the Southern hemisphere 

It is possible to create an astrolabe for the Southern hemisphere, by entering a negative latitude for the plate when 
creating the sundial in Shadows. The stereographic projection is then carried out from the North pole onto the 
equator and the plate corresponds to the southern sky seen from above the South pole of the celestial sphere. 

 

The limb and the ecliptic circle are reversed. 
The plate displays stars and constellations of 
the southern sky. 

Very few southern astrolabes exist in the world, 
but Shadows makes it easy to simulate and 
create them. Hopefully users will realize their 
own ones. 
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How to build an astrolabe 

In order to build an astrolabe, you need to create each element independently before assembling them. It is slightly 
more difficult than building a sundial, but Shadows makes it possible to prepare all the required elements. 

Each element is printed separately and transferred on the final material, then cut by hand, or using a laser cutter (see 
next title). 

For example, for a planispheric astrolabe: 

 

• Below, the matter and the limb. 

• Then a plate, that may be printed on both sides. 

• Then the rete. 

• And finally, the ruler. 

The same operation can be done for the back that can be glued 
behind the matter, and the alidade. 

 

The principle is the same for the other types of astrolabes. 

Building an astrolabe with a laser engraver/cutter 

As for sundials, a export function can create files for a laser cutter, for each element of an astrolabe. Two files are 
created for each element, one for engraving and one for cutting. These files are generated into the Shadows 
Data\Engraving folder. 

For example, for the Rete: 

  

File for engraving File for cutting 

 

The making of each element is done in several passes. First engrave the layout, using a medium power for the laser, 
in order to draw and not to cut. Then, use the cutting file with the maximum power, and double or triple the number 
of passes, depending on the material type and thickness to ensure it is cut throughout. 

The principle is the same for the other types of astrolabes. 

The export function for a laser cutter/engraver is available only in Shadows Pro. 



Reference manual of Shadows Pro – © François Blateyron – page 95 

List of problems solved with a planispheric astrolabe 

Determine the hour and direction of the sunrise (or sunset), at a given date 

 

 

Let's take an example for Paris (latitude 48° 50' N) on 
June 1st. 

We first find the ecliptic longitude of the sun at this 
date, by rotating the alidade, on the back, to June 1st 
(1) 

This corresponds to an ecliptic longitude of 71° (2), or 
Gemini 11°. 

 

 

 

Then on the front of the astrolabe, rotate the rete to 
bring the mark 71° of the ecliptic circle onto the 
horizon, on the sunrise side (3). 

To find the hour of the sunset, use the other side of 
the horizon, on the right of the astrolabe. 

 

 

 

Rotate the ruler to the same point on the horizon (4). 

You can now read the hour of sunrise on the limb (5), 
here approximately 4h10. 
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The azimuth of sunrise is read by looking at the 
azimuth arc ending to the horizon (6), here around 
125° east of south (i.e., 35° north of east). 

 

Determine the instant when the Sun will have a given Azimuth, at a given date 

 

 

Let's take the Paris example again, on June 1st (see the 
previous exercise). At what time will the sun be at 
azimuth 30°, east from the south? 

Let's find the ecliptic longitude for this date, by 
rotating the alidade on the back of the astrolabe to 
point June 1st (1). 

The ecliptic longitude is (2): 71°, or 11° in Gemini. 

 

 

On the front of the astrolabe, rotate the rete to bring 
the mark 71° on the ecliptic circle to the arc of azimuth 
30° (3). 
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Then rotate the ruler to the intersection between the 
ecliptic circle and the azimuth circle of 30° (4) 

Solar time can be read on the limb (5), here around 
10h55 am. 

 

 

We can also determine that the altitude of the Sun at 
this moment is a bit more than 60° (6). 

 

Determine the instant when the Sun will have a given Azimuth and Altitude 

 

 

Let's consider an astrolabe built for Prague, Czech 
Republic (latitude 50° 05' N). When will the Sun be at 
an azimuth of 60° west and an altitude of 20°? 

Rotate the rete to bring the ecliptic circle at the 
intersection of the azimuth arc 60° west and the 
altitude circle 20° (1). 

This point has an ecliptic longitude of about 6°. 
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With the ruler aligned on this point (2), one can read 
solar time on the limb (3), here between 3h35 and 
3h40 in the afternoon. 

 

 

On the back of the astrolabe, rotate the alidade to 
point 6° of ecliptic longitude (4) 

The date is read on the inner ring (5), here March 26th. 

 

Determine the hour of rise (or set) of a star on the rete, at a given date 

 

 

Let's consider an astrolabe built for Casablanca, 
Morocco (latitude 33° 39' N). At what time will the star 
Vega (in the constellation Lyra) set on the horizon, on 
September 21st? 

On the back of the astrolabe, rotate the alidade to 
point September 21st (1). 

The ecliptic longitude is read, around 178° (2). 
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On the front of the astrolabe, rotate the rete until 
Vega is on the horizon, on the evening side (3). 

 

 

Rotate the ruler to point 178° of ecliptic longitude (4). 

Read solar time on the limb (5), here around 2h55 a.m. 

 

 

To find the rising hour of the star, move Vega to the 
other side of the horizon (6). 

Move the ruler to 178° of ecliptic longitude (7). 

Read solar time on the limb (8), here between 10h35 
and 10h40 a.m. 

 



Reference manual of Shadows Pro – © François Blateyron – page 100 

Determine the instant of culmination of a star on the rete, at a given date 

 

 

Let's consider an astrolabe built for Firenze, Italy 
(latitude 43° 46' N). At what time will the star Altair (in 
the constellation of Aquila) culminate above the 
horizon, on September 21st? 

On the back of the astrolabe, we find that the ecliptic 
longitude for this date is 178°, by using the same 
method seen as the previous exercise. 

On the front of the astrolabe, rotate the rete to move 
Altair on the meridian line, between the pole and 
south (1). 

 

 

Rotate the ruler to 178° of ecliptic longitude (2). 

Then read solar time on the limb (3), here between 
7h55 and 8h in the evening. 

  

Determine the maximum altitude of the Sun over a year for a given location 

 

 

Let's consider an astrolabe built for Delft in 
Netherlands (latitude 52° 00' N). 

Bring the mark 90° of the ecliptic circle to the meridian 
line, and read the corresponding altitude on the 
almicantarats (altitude circles). 

The 90° mark is the point where the ecliptic is tangent 
to the Tropic of Cancer, which corresponds to the 
summer solstice in the Northern hemisphere. 

Here we read around 62° of altitude. 

The exact value can be calculated by 90° - 52° + 23.5° 
= 61.5° 
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Determine the maximum altitude of the Sun on November 12th for a given location 

 

 

Let's take the same astrolabe as the previous exercise. 

On the back of the astrolabe, we find that the ecliptic 
longitude on November 12th is 229.5° 

On the front of the astrolabe, bring the 229.5° mark of 
ecliptic longitude to the meridian line and read the 
corresponding altitude on the almicantarats. 

Here we read a bit more than 20° of altitude. 

  

Determine the maximum altitude of a star at a given date, for a given location 

 

 

Let's take an astrolabe built for Cairo, Egypt (latitude 
30° 02' N). 

On the back of the astrolabe, we use the alidade and 
the two pinholes to point a star. The astrolabe must 
be hung by the ring of the throne, vertically. Let's point 
to the star Sirius. We measure for example its altitude 
at 35°. 

Then we find that the ecliptic longitude on April 20th is 
around 30°. 

 

 

On the front of the astrolabe, rotate the rete to bring 
Sirius on the azimuth circle of 35° (1). 
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Then rotate the ruler to point 30° on the ecliptic circle 
(2). 

We read solar time on the limb at the end of the ruler 
(3), here around 2h55 p.m. 

 

 

This problem has a second solution, if we bring Sirius 
on the other intersection with the 35° circle (4). Rotate 
the ruler to 30° on the ecliptic (5), and read the hour 
4h55 (6). 

 

Determine the right ascension and declination of a star 

 

 

Let's consider an astrolabe built for Boston, USA 
(latitude 42° 21' N). 

We will find the right ascension and the declination of 
Betelgeuse (in the constellation of Orion). 

Rotate the rete to bring the star on the meridian line 
(1). 
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Align the ruler with the star and read its declination on 
the ruler marks (2), here approximately 8°. 

 

 

The right ascension is given by the direction of the 
vernal point (Aries 0°). Rotate the ruler to the ecliptic 
longitude 0° (3), and read the right ascension on the 
limb (4), here around 5h 55'. 

The precise coordinates of the star are:    

  = 5 h 55' 

     = 7° 25'. 
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The universal astrolabe 

The universal astrolabe makes it possible to solve the major drawback of the planispheric astrolabe which works only 
for a given latitude. Ancient astrolabes used to be shipped with a set of plates for several latitudes every 5°. 

The universal astrolabe can be used for any latitude. 

Shadows offers the Saphae Arzachelis which was invented in the 11th century by the Andalusian astronomer, 
Arzaquiel. In this astrolabe, the stereographic projection is not made from the pole on the equatorial plane but from 
the vernal point on a plane crossing both poles. 

 

 

1. meridian 

2. parallel 

3. equator 

4. articulated pointer (Brachiolus) 

5. Tropic of Cancer 

6. ecliptic 

7. rotating ruler 

8. Tropic of Capricorn 

The ruler – The ruler can be rotated on screen using the mouse by clicking on one of its ends at 90° or 270°. It is 
scaled in degrees of ecliptic longitude. 

The pointer – also called Brachiolus, can be moved on screen by dragging its end with the mouse. It is made of two 
parts that move with the ruler. 

The universal astrolabe is usually used to convert coordinates. See also the List of problems solved with a universal 
astrolabe. 

The universal astrolabe is available only in Shadows Pro. 
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List of problems solved with a universal astrolabe 

Convert coordinates between ecliptic and equatorial systems 

The universal astrolabe allows the immediate conversion of coordinates. 

 

 

To convert ecliptic coordinates to equatorial 
coordinates, you have to put the ruler horizontally 
and point the coordinate with the Brachiolus 
(articulated arm). 

For example, (1), coordinate 75° of longitude and 
10° of ecliptic longitude. 

 

Bring the ruler on the ecliptic. 

The right ascension can be read with meridians and 
declination with parallels. Here, we read 72° of 
right ascension (or 4 h 48 min), and 32° of 
declination. 
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The mariners’ astrolabe 

The mariners’ astrolabe is mainly offered as an aesthetic object as it is not used for calculations, except for measuring 
angles (horizontal or vertical). 

 

 

The alidade has two small holes used to sight a star 
or a point on the horizon. The two holes need to be 
aligned with the center of the astrolabe (they have 
to be on a diameter) 

The angle is read on the limb. 

 

 

Photo: Museum of history of science, Oxford 

 

The mariners’ astrolabe is available in Shadows Expert and Shadows Pro. 
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PART 4 – OTHER GNOMONIC AND ASTRONOMICAL 

FEATURES  
 

The equation of time 

Origin of the equation of time 

Shadows use by default the French convention for the equation of time: it is defined as the difference between the 
mean time and solar time (see below). 

The equation of time provides the time difference between solar time and mean time. Solar time is given by the 
sun's hour angle; mean time is given by the division of a day by 24 hours of 3600 seconds (the second is a primary 
quantity defined from the light speed). Therefore, solar time is not synchronized with mean time, because of 
variations of astronomical origin. 

From one day to the next, the Earth has progressed in its orbit and the direction of the sun has slightly changed 
(see the figure below). This variation is not constant over the year as the orbital speed varies with the distance to 
the sun (the orbit is elliptical). 

 

 

In addition, the Earth's axis is inclined with respect to the ecliptic plane (the apparent orbit of the Sun). The 
projection of its position on the celestial equator introduces another periodical variation. 

 

The ecliptic plane (red) is inclined on the celestial equator (blue) by around 23°. The A-B arc, travelled by the apparent 
sun is projected in A'-B'. When the sun is close to the vernal point (g) the A'-B' arc is shorter than the A-B arc (left 
above figure). This is the case around the equinoxes. When the sun is close to its maximum declination, around the 
solstices (right above figure), the A'-B' arc is longer than the A-B arc. 
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These two phenomena are at the origin of the equation of time. They are superimposed and give the familiar double-
sinusoidal shape of the curve. 

Convention used for the equation of time 

Two conventions are used for the equation of time: mean time - solar time (the convention in Shadows) or solar time 
- mean time (the convention in most English books). The later reverses the curve but the values are to be used in an 
opposite manner, so that the result is the same. 

This convention may be chosen in the preferences Equation of time. 

The following table explains how to use the value of the equation of time (EoT) given by the program depending on 
the convention: 

 MT – ST * ST – MT  

To get solar time from mean time subtract the EoT add the EoT 

To get mean time from solar time add the EoT subtract the EoT 

* Default value used in Shadows. 

Note: adding a negative number is equivalent to subtracting this number without its sign (12 plus (-5) equals: 12 
minus 5 = 7). Subtracting a negative number is equivalent to adding this number without its sign (12 minus (-5) equals: 
12 plus 5 = 1 

Using the equation of time 

The following explanation is given for the convention used in Shadows (MT-ST) and in parenthesis for the opposite 
convention (ST-MT). When the equation of time is positive (negative), the True Sun (defining the solar time) is late 
(early) compared to the mean sun. The difference can be as much as +/- 15 minutes depending on the date. This 
difference is not negligible at all! It sometimes puzzles people looking at a sundial because the difference with the 
clock time is significant (a lot of people in Europe think that they just need to add 1 hour during the winter and 2 
hours during the summer to the solar time to get the clock time). 

The values of the equation of time are slightly different from one year to the next. That is why it is calculated for the 

reference year, which can be changed in the   General preferences by clicking on the Reference icon. After four 
years, the values become the same again. Therefore, the equation of time can be calculated for a given year or as a 
mean of four years. 

Graph of the equation of time 

This graph shows the values of the equation of time in minutes (ordinates) as a function of the date (abscissa). The 
month is given in Roman numerals. The day of the month is graduated every ten days (1, 11, 21). The equation of 
time contains two periodical terms, one being twice as fast as the other. You can notice that the equation of time 
crosses the zero axis four times a year.  
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The value read from this graph is added to the 
solar time to get the mean time or subtracted 
from the mean time to get solar time.  

To get an accurate value of the equation of 
time for a given date, you have to use the table 
of the equation of time or the ephemeris.  

By clicking on the icon , a vertical cursor is 
drawn on the selected day and the value of the 
equation of time is displayed at the top of the 
graph. The right and left arrows on the 
keyboard allow you to change the day. 

 

This curve can include the longitude correction by activating the  General preferences > Equation of time > 
Include the longitude correction. The color of the curve can also be changed in this preference. 

This graph can be printed and installed beside a sundial to provide a way to correct the solar time read on the sundial.  

 

 

 

The two components of the equation of time 
can be superimposed on the general curve by 

clicking on the  icon. 

The two components are the obliquity of the 
ecliptic (green curve) and the eccentricity of 
the Earth’s orbit (red curve). 
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Graph by months 

This graph displays the equation of time split by month to provide better accuracy. 

 

Vertical graph of the equation of time 

 

 

This graph shows the declination of the sun 
(ordinates) as a function of the value of the 
equation of time (abscissa). The curve has a 
figure-8 -shape, which is obtained by folding 
the graph of the equation of time as a function 
of the date.  

The date is provided next to the curve, marked 
every day by a point, and a number every five 
days. 

This graph provides two pieces of information 
when you know the date: the value of the 
equation of time, and the sun's declination.  
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Solar ephemeris 

An ephemeris is a set of astronomical data calculated for a given date. The data provided here are related to the time 
of the position of the sun.  

Solar ephemeris is available in Shadows Expert and Shadows Pro. 

General ephemeris 

 

General ephemeris is calculated for the Reference date chosen 
in the Preferences and for the Reference location chosen in the 

 Tools menu > Edit the location database… 

This ephemeris provides the precise dates of solstices and 
equinoxes, duration of seasons, duration of the longest and the 
shortest day of the year, dates of perihelion and aphelion, and 
corresponding Sun-Earth distances, precise values of obliquity 
of the ecliptic and eccentricity of the Earth orbit, date of Easter 
and the Qibla (direction of Mecca). 

Times are given in Universal Time. 

Daily ephemeris 

 

Daily ephemeris is calculated for the Reference 

location and for the date selected in the  
Configuration menu > Define the ephemeris date… 

Data are calculated at 0 h UT. Data provided here are: 
date, Julian day, day of the year, day of the week, Julian 
century, equation of time, sidereal time of Greenwich 
at 0 h UT, the position of sun: right ascension, 
declination, hour angle, azimuth, altitude, orbital 
parameters of sun: ecliptic longitude (mean, true, 
apparent), anomaly (mean, true), equation of center, 
the distance of the Earth to the sun, hour of sunrise 
and sunset, the hour of transit at meridian, azimuth at 
sunrise/sunset, the altitude at meridian, duration of 
the day, duration of twilights (civil, nautical, 
astronomical), the apparent diameter of the sun.  
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Instant ephemeris 

 

Instant ephemeris can be calculated for a given instant 

defined in the  Configuration menu > Define the 
ephemeris date… or in real time, updated every 
second (the clock of the PC is used as civil time). 

This section provides data valid for the selected date 
and instant, or recalculated in real time each second. 
Data provided here are: Universal time, civil time, solar 
time, Julian day, equation of time, sidereal time, right 
ascension, declination, distance of the Earth to the 
Sun, hour angle, azimuth, altitude, and zenithal 
distance.  

 

Planetary ephemeris 

 

The planetary ephemeris gives the main orbital data 
and coordinates of the major planets of the solar 
system. 

These data complete the drawing of the planets on the 
star maps. 

The planetary ephemeris is available only in Shadows Pro. 

Ephemeris generator 

This function generates a text file containing a table of data calculated for each hour or each day. The data contained 
can be selected, as well as the number of lines to generate.  

YYYY MM DD year, month, day  

hh mm ss hour, minutes, seconds  

JD Julian day in days 

EoT Equation of time in seconds 

st Sidereal time in hours 

Az Azimuth of the sun in hours 

Ht Altitude of the sun in degrees 

RA Right ascension of the sun in hours 

Dec Declination of the sun in degrees 
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HA Hour angle of the sun in hours UT 

HSe HSw Time of sunrise and sunset in hours UT 

DD Duration of the day in hours 

HSs Meridian transit time in hours UT 

The ephemeris generator is available only in Shadows Pro. 

Lunar ephemeris 

 

The first table gives the hours of moonrise, moonset, 
transit, as well as its altitude at transit and its azimuth 
at the horizon. 

The second table gives the age of the Moon for the 
chosen date as well as the dates of the main phases. 

Icons in the toolbar make it possible to step to the 
next or previous day, or to the next or previous 
lunation. 

Lunar ephemeris are available only in Shadows Pro. 
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The solar graph 

The polar solar graph 

This graph is available from the Display menu > Solar graph. 

 

 

The solar graph represents the horizon circle with 
scales in altitude up to the Zenith, and on which are 
drawn the sun’s trajectories at several moments of 
the year and different moments of the day. 

It is possible to superimpose a horizon mask to show 

obstacles on the horizon by clicking on the  icon. 

This function is available only in Shadows Pro. 

 

The horizontal solar graph 

This graph is available from the Display menu > Solar graph then on the  icon. It displays the sun’s altitude as a 
function of azimuth during the year. The azimuth 0° corresponds to the direction of the local meridian (direction of 
the south in the Northern hemisphere). 

This graph is useful for predicting the duration of sunlight on a sundial and moments where it will be in the shadow 
of an obstacle (building, tree, etc.) and so cannot give time. 

This function is available only in Shadows Pro. 

The horizon mask 

It is possible to define a horizon mask describing the obstacles on the horizon that may affect the illumination of the 
sundial. The mask is defined by a series of points (altitude for a given azimuth). An altitude of 0° lays on the horizon, 
an altitude of 90° is at the zenith. It is possible to draw houses and trees that may cast a shadow on the sundial. The 
horizon mask is saved in a text file HorizonMask.txt which is loaded automatically when the dialogue is open and 
saved when the dialog is closed. Only one mask can be defined at a time.  
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Other graphs and tools 

Time of sunrise and sunset 

This graph is available in the Display menu > Solar graph then by clicking on the  icon. 

This graph provides the civil time (watch time) of sunrise, meridian transit and sunset as a function of the date, for a 
given location. The longitude correction is already included in the graph.  

 

1. Solar noon – meridian transit time. 

2. Sunrise 

3. Sunset 

Colored areas outside the sunrise and sunset curves are 
twilights, with, from the lighter to the darker: the civil 
twilight, the nautical twilight and the astronomical twilight. 

This graph is calculated for the Reference location. The reference location can be changed in the location database. 

   

Above: the left graph is calculated for Dakar, Senegal (latitude 14° 40'); it can be noted that the duration of the day is 
almost the same for the entire year. In the middle, the city of Brussels, Belgium (latitude 50° 50'), the duration of the 
day is around 8 hours in winter and more than 16 hours in summer. On the right, a location at 80° of latitude where 
there are periods of continuous night and continuous day. 

 

Graph of efficiency of a solar panel 

This graph is available from the Display menu > Solar graph and by clicking on the  icon. 
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This graph provides the efficiency rate in % for the 
solstices and equinoxes. The efficency is maximum 
when the sun is facing the panel. 

The value on the right axis is the angle of the sun from 
the perpendicular direction of the panel. 

By double-clicking on the graph or clicking on the  
icon, you can configure the orientation and inclination 
of the panel, and select the location of installation. 

Solar panels installed on and parallel to the roof of a house cannot be oriented optimally. This function makes it 
possible to predict the efficiency of the panel. Note that the value does take into account light absorption due to the 
weather or the atmosphere (at low altitude). 

The mobile sky map with horizon 

The sky map is available from the Display menu > Solar graph and by clicking on the  icon. 

 

 

The map displays selected stars and 
constellations inside the horizon circle of the 
selected location, for a given date and time. 

Several options are available in the toolbar: 

 : Display tropic circles 

 : Display celestial equator 

 : Display ecliptic circle 

 : Display equatorial scales 

 : Display horizontal scales 

 : Display horizon mask 

 : Change the reference location 

 : Change the date 

 

 : Display the position of sun, Moon and/or 
other planets, and their names. 
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 : display the dialog to select the display 
options of stars and constellations. 

In order to build this sky map on paper, first print the map background without the horizon mask, then print the 
mask alone and cut its window. Then assemble the two parts and fix them with a pin that allows the map to rotate. 

The classical sky map 

This map shows the sky in horizontal coordinates, as we use to see it. Constellation and star names can be displayed. 

 

The classical sky map is available in Shadows Expert and Shadows Pro. 

The protractor 

The protractor is available from the Display menu > Drawing tools and by clicking on the  icon. 
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This protractor is provided to make the drawing of the sundial easier on real material (wood, marble, etc.). Tables of 
coordinates give Cartesian and polar values and it is sometimes easier to use polar coordinates on large sundials. The 
accuracy of the drawing can be improved with protractors larger than the ones that can be found in stores. 

The default drawing provides a 12 cm radius protractor on an A4 page. Go to Configuration > Dimension of the 
drawing… to set the number of pages on which to draw the protractor. It is then possible to print it directly on an A3 
page to have a bigger one. 

 

 

Then paste the page on cardboard and cut 
around and inside the circle. Sundial drawings 
can then be made with this protractor and a 
long ruler.  

 

 

To increase the accuracy of measurement, it is 
possible to display an interpolation abacus by 

clicking on the  icon. 

It makes it possible to assess 1/10 of a degree 
by dilating along the radial direction the lateral 
space between two scale bars. 

 

The azimuth circle 

The azimuth circle is available from the Drawing menu > Drawing tools and by clicking on the  icon. 

 

This option allows one to draw a big circle 
graduated in degrees and hours. This circle can be 
used to measure an azimuth or an hour angle, or as 
an equatorial or a declination circle. 

Its size can be selected in  Dimension of the 
drawing… which allows you to choose on how many 
pages the circle will be drawn. In this case, be sure 

to draw the printing cutouts, in  General 
preferences > Document; it will make it easier to 
assemble precisely all pages.  

 



Reference manual of Shadows Pro – © François Blateyron – page 119 

The tangent network 

The tangent network is available from the Display menu > Drawing tools and by clicking on the  icon. 

This network is aimed at helping one to measure the declination of a wall. You need to put the network against a wall, 
the lines vertically (parallel to a plumb line). 

A style is installed on the 0° line, perpendicularly to the sheet. By default, the style height is set to 50 mm. By hitting 
the + or - keys of the keyboard, you can enlarge or reduce the style height by 5 mm. 

The method to measure the wall declination is given in the following page Find the declination of a wall. 

In order to increase the precision, it is recommended to print the network on several pages. To do so, go to 
Dimensions of the drawing... and set the number of pages. Used together with a large style, it will allow a better 
precision. When the distance between two lines is large enough, a dashed line is drawn for every 1/2 degrees.  

 

The compass rose 

The compass rose is available from the Display menu > Drawing tools and by clicking on the  icon. 

 

A compass rose made for  
Johannesburg (South Africa) 

The compass rose is a disk giving the direction and the 
distance to the cities or points of interest. It can 
sometimes be seen in viewing points showing summits 
around the horizon.  

To define points of interest, select  Configure the 
compass rose in the Configuration menu. In the dialog 
box, select the origin location (upper right), then add 
locations (points of interest) that will be shown on the 
compass rose. 
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The compass rose is available in Shadows Expert and Shadows Pro. 
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Determination of sundial parameters from a photo 

This tool is available from the Tools menu >   Determination of sundial parameters from a photo... This tool 
allows one to find for which latitude a vertical sundial was designed, and with which orientation. 

The tool works only for vertical sundials, facing south or any direction within +/-90° from the south (or the north in 
the Southern hemisphere). 

 

1. Load an image – Click on the button Load a photo and select an image file. Files can be in BMP, JPG or GIF format. 
For a better precision, the photo must have been taken in front of the sundial, without any parallax (horizontal or 
vertical), and without optical deformations due to the camera. You can check that the sides of the sundial are parallel 
to the frame of the photo.  

2. Place the segments on hour lines – The middle segment must be placed on the solar noon line. Place one line on 
each side of the noon line. Move the segments by clicking on their handles on each end. Enter the solar time 
corresponding to each line. They must be integer hours.  

3. Calculate 

The following information is provided: 

• The latitude of the sundial; 

• The declination of the wall, with respect to the meridian direction (south or north). A negative value means 
that the wall is east from south (in the Northern hemisphere) or east of north (in the Southern hemisphere); 

• The sub-style angle with respect to the noon line. A negative angle means that the sub-style is on the left of 
the noon line (in Northern hemisphere), and that the sundial is facing east from the south. The sub-style line 
is drawn with a dashed line. 

With a good photo, the latitude can be estimated with an accuracy of approximately 1° and the orientation with an 
accuracy of around 2° to 3°. Errors usually come from the position of segments on the photo.  

Photo: Mickaël Porte 
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Determination of a horizontal sundial parameters from angle measurements 

This tool is close and complementary to the previous one, except that it works for horizontal sundials. The user needs 
to measure the angle from hour lines and the solar noon line.  

 

 

Shadows will calculate the estimated latitude from the angle measurements, plus or minus an interval that 
corresponds to one or two standard deviations. The calculation of latitude is very sensitive to the accuracy of 
measurement of angles. A deviation of 0,1° on the angle may generate a deviation of 0,5° on the latitude. This is why 
it is important to measure angles as precisely as possible, and to measure many hour lines on both sides of the noon 
line, in order to improve the accuracy of the average latitude. 

It is then possible to review a list of locations compatible with the band of latitudes, within the selected country. The 
list is sorted after the deviation from the mean latitude. And it is possible to directly create an horizontal sundial 
made for the selected location. 
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PART 5 – EXPLORING FURTHER 

 

Become a member of a sundial society 

If you want to meet other sundial enthusiasts, discuss technology and history, and learn from experienced users, 
become a member of a sundial society.  

British Sundial Society (BSS) 

c/o The Royal Astronomical Society, Burlington House, Piccadilly, London W1J 0BQ, United Kingdom 

www.sundialsoc.org.uk  

 

North American Sundial Society (NASS) 

c/o Frederick W. Sawyer III, 27 Ninas Way, Hampton Run, Manchester CT 06040-6388, USA 

www.sundials.org  

 

from other countries 

France:   www.commission-cadrans-solaires.fr  

Italy:   www.gnomonicaitaliana.it  

Spain:   www.relojesdesol.info  

Spain (Catalonia)  www.gnomonica.cat  

Austria:  www.gnomonica.at  

 

  

http://www.sundialsoc.org.uk/
http://www.sundials.org/
http://www.commission-cadrans-solaires.fr/
http://www.gnomonicaitaliana.it/
http://www.relojesdesol.info/
http://www.gnomonica.cat/
http://www.gnomonica.at/
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Perseus Books, ISBN 0306457873, 1998 

 

Longitude: the true story of a lone genius who solved the greatest scientific problem of his time, 
by Dava Sobel, Harper Perennial, ISBN 0007214227, 2005. A great book about an incredible story! 

 

Books about astronomical calculations 

Astronomy on the personal computer, by Richard M. West, Springer, ISBN 3540672214, 2000 

 

Astronomical algorithms, by Jean Meeus, Willmann-Bell, Richmond, ISBN 0943396611, 1998 

The best book ever published on astronomical equations and algorithms! 

 

Books on astrolabes 

A treatise on the astrolabe, by Walter William Skeat et Geoffrey Chaucer, Ed. BiblioBazaar, ISBN 1-
1036-3101-2    

 

The astrolabe, by James E. Morrison, Ed. Janus, ISBN 0-9393-2030-4. An excellent book that makes 
a synthesis of what was written on astrolabes up to now. 

 

Astrolabes at Greenwich: A Catalogue of the Astrolabes in the National Maritime Museum, by 
Koenraad van Cleempoel, Oxford, 2006, ISBN 0-1985-3069-2    

 

Al-Farghani, On the astrolabe, by Richard Lorsch, Franz Steiner Verlag, ISBN 3-515-08713-3    

 

L'astrolabe, histoire, théorie et pratique, de Raymond d'Hollander, Ed. Institut Océanographique, 
Paris, ISBN 2-9035-8119-3, 1999. Reference book (in French) for the construction and the use of 
various types of astrolabes. Describes both calculations and geometrical constructions. 
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Glossary of technical terms 

Abscissa – Name given to the horizontal component of a Cartesian coordinate. The abscissa is usually written x. 

Alidade – Ruler equipped with pointers, that can be rotated to measure angles. Alidades are usually found at the 
back of astrolabes. 

Almucantarat – Arc drawn on an astrolabe, to mark the altitude of a star. Sometimes called Almucantar. 

Altitude – Angle measured vertically from the horizon up (or down) to the celestial object, yielding values between -
90° and 90°. The altitude is part of the horizontal coordinates system (with the azimuth). At sunrise or sunset, the 
altitude of the Sun is 0°. 

Analemma – Name given to the figure-8 -shaped curve drawn sometimes at the position of an hour line (usually the 
noon line). 

Analemmatic – Used to qualify a sundial of elliptical shape for which the style must be moved (on a line) to a position 
depending on the date. Analemmatic sundials are usually big and drawn on the ground so a person’s body is used as 
a style. 

Anomalistic year – Time between two consecutive transits of the Earth at its perihelion; it equals 365 days  
6 h 13 m 53 s. 

Arcdegree – Unit used to measure angles. It corresponds to 1/360 of a circumference. A degree contains 60 
arcminutes of 60 arcseconds each. 

Arcminute – Unit used for angle measurement. There are sixty arcminutes in a degree. One arcminute contains sixty 
arcseconds. 

Arcsecond – Unit used for angle measurement. There are sixty arcseconds in an arcminute. 

Armillary sphere – Sphere reproducing the Earth, inclined parallel to the polar axis. Its equator is graduated to give 
the hours by the shadow cast by the pole axis of the sphere. It is a kind of equatorial sundial. 

Atmospheric Refraction – Deviation of light rays due to variations in the atmosphere’s ability to bend light. The effect 
is often most visible when the celestial body is close to the horizon. For example, the image of the sun can be visible 
above the horizon while the sun is below. The effect is usually around 36 arcseconds on the horizon. 

Azimuth – Angle between a vertical plane passing through a given point in the sky, and the meridian plane of the 
location. The azimuth is counted positively from the south to the west. 

Babylonian hours – The Babylonian hours were counted from the sunrise (with constant duration for an hour, 
contrary to the temporary hours). Babylonian hours were useful to know the time since the sunrise. Those hours 
were used by the Chaldeans, the Egyptians, the Persians, the Syrians and the Greeks. 

Brachiolus – Articulted arm used on universal astrolabes (Saphae Arzachelis) to point a particular coordinate. 

Butterfield – Type of portable horizontal sundial, equipped with a foldable style that can be adjusted in latitude. It 
has several sets of hour lines, in concentrical bands to allow the reading of time at several latitudes. These sundials 
are often made in precious material (such as silver). 

Celestial equator – Projection of the Earth's equator on the celestial sphere. 

Circle (great circle, small circle) – A great circle is a circle on a sphere whose diameter is the same as the diameter of 
the sphere. Meridians and the equator are great circles of the Earth. A small circle is a circle on the sphere whose 
diameter is smaller than the diameter of the sphere. A parallel at a latitude greater than 0° is a small circle. 

Civil time – Mean time of the reference meridian, shifted if needed by one hour if the daylight saving time is used. 
Civil time is clock time. 

Colatitude – Is the complementary angle of the latitude, taken from the pole. The co-latitude is (in degrees) equal to 
90° - latitude. 

Declination – Angular distance of a point on the celestial sphere to the equatorial plane, with the convention of 
positive (0° to 90°) toward the north, negative toward the south. 

Declination arc – Trajectory of the shadow's endpoint on the sundial, during the day. This curve is usually an 
hyperbola, except for the equinox where it is a straight line. 
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Declination lines – Lines indicating the date using the end of the shadow of the style. The lines are generally drawn 
for every Zodiac change (corresponding to the declinations 0°, +/-11°29', +/-20°20' and +/- 23°26'). 

Diptych sundial – Sundial formed of two articulated parts, one horizontal, one vertical, with a common style realized 
with a thread. It is a portable sundial that can be kept in a pocket. 

Ecliptic – [1] Plane of the Earth's orbit around the sun. [2] Large circle on the celestial sphere, where the sun moves 
in its apparent motion. 

Ecliptic longitude – Angle counted on the Earth orbit between the position of Earth and the Vernal point. It is 
separated in sectors of 30° that define astronomical zodiac signs. 

Equation of time – The difference between solar time and mean time. This equation varies during the year and its 
value can reach ±16 minutes. 

Equinox – One of the two days in a year, when the sun is crossing the celestial equator. At the equinoxes, the day 
and the night have the same duration. 

Equatorial coordinates – Right ascension and declination of a star. Coordinate system anchored on the ecliptic. The 
origin of the right ascension is the vernal point; it is counted from 0 to 24 hours anticlockwise. The declination is 
counted from 0 to +/- 90° around the equator. 

Geographic north – Direction included in the meridian plane, pointing towards the geographic north celestial pole. 
It's the direction used in gnomonics (not the magnetic north). 

Gnomon – Primitive sundial made of a simple rod whose shadow is cast on the ground. Today, this term is used to 
name the style planted perpendicularly to the sundial table. 

Gnomonics – The science of sundials. 

Greenwich – English city located near London. 

Greenwich meridian – Meridian crossing the Greenwich observatory, used as the reference meridian to measure 
longitudes on Earth. 

Greenwich Mean Time (GMT) – Time equals the civil time of Greenwich shifted by 12 hours. This time should not be 
used to call the standard time of Great Britain, which has been replaced by the Universal Time. 

Hemisphere – Half of a sphere, separated by an equator plane. On Earth, there is the northern (or boreal) hemisphere 
and the southern (or austral) hemisphere. 

Horizontal coordinates – Azimuth and height of a star. This coordinate system is local to the observer. The azimuth 
is counted from 0 to 180° starting on the local meridian. The altitude is counted from 0 to 90° above the horizon. 

Hour Angle – Angle between the plane of the great circle through an object and the meridian of the location. It is 
calculated in a retrograde sense, sometimes in degrees, but more often in hours, from 0 to 24 hours, or from -12 to 

+12 hours. The hour angle (H) and the right ascension () are related to each other and to the hour angle of the 

Vernal Equinox (T) by the following formula: T =  + H. 

Hour coordinates – Hour angle and declination. This system is intermediate between the horizontal system and the 
equatorial system (using it simplifies the coordinate conversion). The origin of the hour angle is the local meridian. 

Hour line – The lines that allow you to read the hour using the shadow of the style. 

Hypotenuse – Longest side of a right triangle. The side opposite the right-angle. 

Italic hours – The italic hours were counted from the sunset of the previous day. Those hours were in use until the 
end of the 18th century in Italy. 

Latitude – Angle formed, in a given place, by the local vertical and the equatorial plane. The latitude is counted from 
the Earth equator, positively towards the north (from 0° to 90°), and negatively towards the south. 

Leap year – Year that contains 366 days, obtained by the insertion of an additional day on February 29th, every four 
years. This procedure provides a mean year duration of 365.25 days which is close to the anomalistic year duration. 
Years for which the millennial value is dividable by 4 are leap years, except those which are not multiples of 400! For 
example: 1968, 1996, 2000 are leap years but 1900 and 2003 are not. 

Longitude – Angle formed by the local meridian and the Greenwich meridian, counted from 0° to 180°, starting at 
Greenwich, positively towards the west. 
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Magnetic north – Direction given by a compass. It varies from one place to another due to variations in the local 
magnetic field of the Earth. This direction cannot be used in gnomonics to obtain accurate results. 

Mean time – It's the solar time corrected by the equation of time. From mean time, you can add the longitude 
correction to obtain the civil time. 

Meridian – [1] Set of all locations having the same longitude on Earth. [2] Plane defined by the local vertical line 
(plumb line) and the axis of rotation of the Earth. (meridian plane). [3] Half circle of the celestial sphere passing 
through the pole and the local zenith. 

Motto – Phrase written on sundials, expressing philosophical ideas, usually about the passing of time and the 
condition of humans. Mottoes are historically in Latin but can be in any language or dialect. 

Nautical twilight – Instant when sun reaches 12° below the horizon, and when it becomes difficult to distinguish the 
horizon line at sea. 

Obliquity of the ecliptic – Angle between the Earth's rotation axis and the Earth's orbit rotation axis. Its value is 23° 
26'. 

Ordinate – Name given to the vertical component of a Cartesian coordinate. It is often written y. 

Polar style – Style that points towards the celestial pole. It is represented by the hypotenuse in a triangular style. The 
hour lines converge at the foot of the polar style which is labeled point B, in this program. For some sundials, this 
point is projected far from the foot of the perpendicular style. 

Radian – Unit used in the angle measurement. There are 2 radians in the circumference of a circle. One radian 

equals 180/ degrees. 

Revolutionary time – Decimal hour containing 100 minutes of 100 seconds. A day contains ten revolutionary hours. 
This measure of time was established in 1790 by the French revolutionary council, but has never really been used. It 
was soon made obsolete. 

Right ascension – Angle formed by the plane passing through a given point of the celestial equator and the vernal 
point. It is counted from 0° to 360° or more likely in hours from 0 h to 24 h. 

Sidereal Time – Hour angle of the Vernal Equinox (T). It is used to define the relative position of the equatorial and 
hour coordinates. 

Solstice – One of the two times in the year when the sun is farthest away from the equator. In the Northern 
hemisphere, the summer solstice is on June 21st or 22nd, the winter solstice is on December 21st or 22nd. In the 
Southern hemisphere, it is the opposite. 

Solstice arc – Declination arc drawn on the solstices. The solstice arcs limit the shadow's extension on the dial. 

Stereographic projection – Projection of the surface of a sphere onto a plane, seen from a particular point. It is used 
on a planispheric astrolabe to project the celestial sphere onto the equatorial plane, seen from the South pole. 

Style – A rod inserted in the table of the dial. Its shadow gives the hour. The style (polar style) is parallel to the polar 
axis of the Earth. 

Sub-style line – Line joining the points A and B (in the drawing), between the attach points of the polar style and the 
perpendicular style. 

Sundial – Surface with graduations for the hours during the day, on which the shadow of a style is projected by the 
sun to indicate the hour. 

Sundial declination – Angle measured between the normal of a wall and the local meridian plane. It is used for 
example on a vertical declining sundial. The declination is counted positive towards the west, from the south. 

Temporary hours – Antique hours counting 12 hours between sunrise and sunset. The duration of one hour counted 
in this system is varying between 40 and 80 minutes throughout the year. These hours are sometimes called Planetary 
hours. 

Time Zone – Strip of 15° of longitude stretching from the North pole to the South pole, which allows the globe to be 
split into 24 segments. Each zone is centered on a meridian at a multiple of 15°. The meridian of origin is that of 
Greenwich, which defines Universal Time. This zone occupies the longitudes +7.5° to -7.5°. Each country uses, in 
principle, the hour of the nearest zone in longitude, but this is not the case in Europe where most countries (including 
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France) have adopted the zone UT + 1h. Each time zone is one hour apart. However, some countries have adopted 
an offset that is not an exact hour, like the center of Australia which is at UT + 9h 30m or Nepal, at UT + 5h 45m. 

Tropic – Each of the two parallels at latitude 23°27’ N and S where the sun reaches the zenith at a solstice. They 
define a band where the sun can pass the zenith and be in the north direction (Northern hemisphere) or in the south 
direction (Southern hemisphere). The northern Tropic is called the Tropic of Cancer and the southern tropic is called 
Tropic of Capricorn. 

Universal Time – Universal Time (UT): Standard Time of Greenwich. 

Vernal point – Intersection between the ecliptic and the celestial equator. The vernal point corresponds to the 
direction of the sun when its declination crosses 0° upward (it is then the beginning of spring). The vernal point is 

noted . 

Zenith – Point of the celestial sphere situated exactly above the local vertical ascending direction. 

Zenithal distance – Complementary angle of the altitude, equal to 90°-altitude. The zenithal distance is counted from 
the zenith point above the observer. 

Zodiac – A set of celestial constellations located on the ecliptic, were the sun moves in its apparent motion. This band 
is divided into twelve constellations (the astronomers include a thirteenth Zodiac constellation). The sun moves from 
one constellation of the Zodiac to another, when its declination reaches certain values (0°, ±11°29', ±20°20' and 
±23°27') 

Zodiac arc – Declination arc drawn for a date corresponding to a Zodiac sign change, which is around the 21st of each 
month. There are seven Zodiac signs, among which one is for the equinox, two for the solstices.  

  



Reference manual of Shadows Pro – © François Blateyron – page 131 

Complements 

Frequently Asked Questions 

Answers to the frequently asked questions can be found on the Web site, at: www.shadowspro.com/help  

Troubleshooting Shadows  

If you encounter any problem with the software, please carry on the following steps: 

• Go to Help >  About Shadows… and check which version number you have 

• Go to www.shadowspro.com and check if a new version is available 

• If yes, download and install it 

• If the problem is still visible with the latest version, check in the FAQ if a solution is described 

• Contact the author and describe the problem as accurately as possible, and send the Trace files that you can 

find in Help > Troubleshooting >  Display the trace file … 

In case you detected a actual problem, the author will fix it as soon as possible and will publish a new version. Note 
that only the Windows platforms that are officially supported will be considered. 

Please report bugs or problems, and send photos of sundials you may have constructed, by sending an E-mail to: 
info@shadowspro.com  

Shadows End User License Agreement 

The latest version of the End User License Agreement (EULA) can be seen on the Web site, at  
www.shadowspro.com/en/license-agreement.html   

How to translate the program? 

Shadows is developed in French and English by the author. Other translations have been made by users. Translations 
of the user interface can be modified by users themselves and new translations can be proposed to the author. 

A complete translation includes: 

• strings from the user interface, 

• help files or from version 4, the user manual. 

It is possible to use the program in one language and use another language for help. 

How to translate the user interface? 

Strings are stored in a text file called shadows.language.txt. This file can be loaded in Excel, for example. The first 
four columns are keywords used by the program to find the right string. Then, there is one column of text by language. 

To modify the translation file, go to the menu Help > Translations > Open the translation table. The file is opened 
with Excel. Once modifications are made, save it (it must be saved in Unicode Text file format under the name 
shadows.language.txt in the folder My Documents/Shadows Data). Then you can check the results in Shadows by 
selecting Reload the translation file on the same menu. 

It is possible to add a new language that is not yet available in the program. After the first header lines, one can find 
two lines used to declare language names. The first one contains the English name of the language (i.e., German). 
The second line contains the local name of the language (i.e., Deutsch). 

If a particular string is not translated, the program will use its English or French translation instead, depending on the 
language preference. 

The two columns containing French and English translations must not be removed or reversed. Other languages may 
be declared in any order. 

Advice to translators: you can load the file into Excel, write the translation in the right column (or modify an existing 
one) and you can read the existing translations on the same line to better understand the meaning. It is important 

http://www.shadowspro.com/help
http://www.shadowspro.com/
https://www.shadowspro.com/en/license-agreement.html
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not to modify or remove the symbols used sometimes in a sentence (such as \n, %d, %s, etc.). Some lines also do not 
need translation as they are neutral (the same in all languages). They are marked with the keyword SKIP in the first 
column. Then, when finished, just save the file and test it directly in the Shadows program. Once fixed or completed, 
you can send the file to the author in order to include it in the installation package for distribution to everybody.  

How to translate the user manual 

If you want to translate the user manual, contact the author to get the Word document and modify it directly.  

Add your own mottoes 

Mottoes installed with the program are stored in a text file named mottoes.txt. 

The first lines of the file are comments, and begin by (;). 

Each motto is written on a line with some keywords inside brackets < and >: 

<LANG:English> I tell only sunny hours. <COMMENT:this is a comment> 

The keyword <LANG:> specifies the language of the motto. The name of the language will be taken into account ‘as 
is’ and english and anglais will be considered as two different languages. 

An optional comment can be added to the motto with the keyword <COMMENT:>. It may be used to provide a 
translation or indicate the reference of the source. This comment is not displayed on the sundial but it will be visible 
in the dialog box. 

Users adding mottoes are invited to send them to the author so that other users can also enjoy them. 

Add new locations in the database 

The location database is saved into one or two text file(s) organized in a particular manner. Shadows comes with a 
predefined database stored in the file shadows.database.txt in the installation folder. When you add new locations, 
they are saved into the file shadows.userdatabase.txt in order to avoid overwriting new locations when a software 
upgrade is performed. This file is saved in My Documents/Shadows Data. 

If you have entered new locations, you can send your file shadows.userdatabase.txt to the author and allow all users 
to use these locations. 

It is possible to edit the file to fix or complete some records but you should be very careful when doing so. You should 
backup the original file before any change. If the file has been changed incorrectly, it could corrupt the whole program. 

File Format: 

$VERSION 7 

$NBRECORDS 2755 

NEW$ORLEANS LA USA 29.950000 90.066667 -6 1 

NEW-YORK NY USA 40.716667 74.066667 -5 1 

OKLAHOMA$CITY OK USA 35.466667 97.500000 -6 1 

FIRENZE ? ITALY$(ITALIA) 43.766667 -11.250000 1 1 

FOGGIA ? ITALY$(ITALIA) 41.450000 -15.566667 1 1 

FOLIGNO ? ITALY$(ITALIA) 42.950000 -12.700000 1 1 

GELA ? ITALY$(ITALIA) 37.066667 -14.250000 1 1... 

$END 

Reserved keywords start with the character $. Lines with keywords should not be modified. 

$VERSION provides backward compatibility in case of evolution of the file format. 

$NBRECORDS provides the number of records in the file. This value is used as a check. If you add some records 
manually, do not forget to update this value. 

$END should be at the end of the file. 

Each record is defined with several fields separated by a "tabulation" character. The name of the city and of the 
country should not contain any space; therefore, space characters are replaced by “$”:  

GREENWICH$OBSERVATORY ? ENGLAND$(UK) 51.466667 0.000000 0 1 

SAN$MIGUEL$DE$TUCUMA ? ARGENTINA -26.816667 65.216667 -3 1  

The first field is the name of the city (or location). 
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The second field in the zone (district, state, region, etc.), or contains the character “?” if not used. 

The third field is the country. 

Coordinates are given after the country name:  

SYDNEY ? AUSTRALIA -33.866667 -151.216667 10 1 

In the above example, the latitude is 33° 52' south (-33.866667° in decimal), and the longitude is 151° 13' east (-
151.216667° in decimal), and the time zone is UT+10h. The minus sign "-" in the longitude indicates a place located 
east of Greenwich meridian, and in the latitude it indicates a Southern hemisphere place. The time zone may be 
positive or negative, and be integer or decimal:  

MARACAIBO ? VENEZUELA 10.666667 71.616667 -4 1 

RAIPUR ? INDIA 21.233333 -81.633333 5.5 1 

KATHMANDU ? NEPAL 27.716667 -85.316667 5.75 1 

After the time zone, a number indicates if the location is standard (1) or has been created by the user (0). 

  

Edit / Modify a location 

This dialog allows you to enter a new location or to modify an existing one. Names are converted into capital letters. 

The country will be used to sort the locations. If it is a new country, it will be added to the list of countries. You need 
to spell the country precisely and always the same way (BELGIQUE and BELGIUM will be considered as two different 
countries). 

The field Zone allows you to enter a district, a state or a region. For example French districts are labeled by their 
number (Paris is 75); American states are denoted by their two-letter abbreviations (CA for California). 

Latitude and longitude are entered in two parts: degrees and arc-minutes. Do not enter signs but use the radio 
buttons to indicate the direction (east or west, north or south). 

Note: if you know the latitude in decimal form (ex: 47.267°), you need to calculate the number of arc-minutes for the 
decimal part. To do so, multiply the decimal part by 60 and keep the integer part: 0.267 x 60 = 16.02'. So, 47.267° 
will be entered as 47° 16'. Arc-seconds can be neglected (0.02' = 1.2") 

The Time Zone can be selected in the list. UT means Universal Time (i.e., the time of Greenwich). UT + 3 h means that 
the location has a time shift of three hours from Greenwich (and it is east of Greenwich). The additional shifted due 
to the daylight-saving time is not taken into account here. The longitude correction between the location and the 
chosen meridian is given below. In general, this correction should not exceed +/- 2 hours. 

In France and occidental Europe, except Great Britain and Portugal, the standard meridian is UT + 1 h.  

Import a location from Google Maps 

Google Maps is a widely used tool that provides a free map of any place in the world. It can be used to find your 
location and to insert the coordinates of this place into Shadows by copy-paste. 

To import a Google Maps place into Shadows: center the place on the map in Google Maps, then click on the link 
Obtain the URL of this page. Then copy the address line of your Web browser and open in Shadows the dialogue of 
a new location, then click on the button Paste an URL in the Google Maps frame. The latitude and longitude of the 
place are automatically recognized. You will need to enter the name, country, and time zone. 

Google Maps can be reached from maps.google.com 

Import a location from Google Earth 

Google Earth is a very accurate tool for the visualization of the Earth surface. It allows the user to save the 
geographical coordinates of a viewed place on screen. Shadows now includes an interface with Google Earth to 
visualize locations of the database and import coordinates from Google Earth. 

• Defining a place in Google Earth: the compatible locations with Shadows are the placemark represented by 
a pin or square icon. 

• Saving a location file in Google Earth: click on a placemark with the right button of the mouse and select 
Save As.... Give a name to the file and select type KML in the type list (do not save in KMZ). 
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• Importing a file from Google Earth to Shadows: once the KML file is created, click on the button Import a file 
in the New location dialog box of Shadows then select the file. 

• Copying a place from Google Earth into the clipboard: click on a placemark with the right button of the 
mouse and select Copy. 

• Pasting a Google Earth place into Shadows: click on the button Paste a location in the New location dialog 
box of Shadows. 

Captured information: the location name and the country (if it exists) as well as its coordinates (latitude and 
longitude) are captured. You will have to enter the Time Zone manually and, in some cases, the country. 

Google Earth can be downloaded from earth.google.com 
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This manual unveils the secrets of two of the most ancient astronomical 
instruments, the sundial and the astrolabe, by explaining how they work, how to 
understand their layout, and by describing how to realize them by yourself. 

  

It is also and mainly the reference manual of the Shadows Pro® software, which 
makes it possible to simulate and draw these instruments on screen, with many 
drawing options and a great accuracy. 

 

Become an expert of Shadows Pro® and in the understanding of sundials and 
astrolabes. 

 

Download Shadows™ and get other resources on: 

www.shadowspro.com 


